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Preface

This Oracle Arqus Insight Installation Guide describes installing — or upgrading to —
Argus Insight 8.1.1. You perform some of these tasks once. Other tasks you repeat as
your system and business requirements change.

Where to Find More Information

Oracle Help Center

The latest user documentation for Oracle Health Sciences products is available at
http://docs.oracle.com/en/industries/health-sciences/.

My Oracle Support

The latest release notes, patches and white papers are on My Oracle Support (MOS) at
https://support.oracle.com. For help with using MOS, see
https://docs.oracle.com/cd/E74665_01/MOSHP/toc.htm.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.
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Introduction

Argus Insight is a highly optimized reporting module for querying, case series
management and reporting that compliments Argus Safety.

The Argus Insight Extract Transform and Load (ETL) engine extracts data from the
Argus Safety database and populates Argus Insight data mart in a format to enable
efficient querying. The query, drill-down, and output features of Argus Insight let you
analyze your safety data from a scientific angle and produce queries, case series and
reports that provide medical and scientific understanding of your aggregated adverse
event information.

Argus Insight also supports Argus Mart as an additional data source. If you are using
Argus Mart as a data source in a multi-tenant environment, then you may create
Argus Mart Advanced Condition that queries Argus Mart database.

Note: Power Reports has been renamed Argus Insight.

1.1 Argus Insight Product Overview

In Argus Insight, you can generate a report through a query. The query retrieves a set
of specific type of cases (Case Series) from the data mart (Insight Mart/Argus Mart)
and then runs the report on only those cases.

Use these Argus Insight components to retrieve the Case Series: Query By Example
(QBE), Filters, and Advanced Conditions. Next, run reports using any of the supported
reporting tools (BIP/BusinessObjects/Cognos) on these Case Series.

The following flowchart shows the typical workflow for generating a report.

Introduction 1-1
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Table 1-1 describes the various features of Argus Insight:

Table 1-1 Argus Insight Features

Features Description

Query by Example Lets you create simple queries by entering specific values in fields on
(QBE) a form that looks substantially like the Argus Safety case form.
Filters Lets you create queries by selecting a set of predefined fields and

specifying multiple values in a field.

Advanced Conditions  Lets you create complex queries by selecting any of the various
different fields in the data mart (Insight Mart/Argus Mart) and
applying Boolean and Set operations on them. You may use
Advanced Conditions to query data on Argus Mart.

Case Series A list of cases that match the query criteria with revisions (applicable
only for Argus Mart).
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Software and Hardware Requirements

1.1.1 Argus Insight Architecture
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1.2 Software and Hardware Requirements

Table 1-2 lists the software and hardware requirements for the following components
in an Argus Insight installation:

= Argus Insight Web Server
s Database Server

= BusinessObjects Server, Cognos, or OBIEE/BI Publisher (depending on which
Business Intelligence tool you are using with Argus Insight)

Note: Argus Insight can be used together with a reporting tool,
which can be BusinessObjects, Cognos, OBIEE/BI Publisher, or any
combination of these.

= Argus Insight Client
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Software and Hardware Requirements

Table 1-2 Argus Insight Software and Hardware Requirements

Component

Requirements

Argus Insight
Web Server

Supported Operating Systems:

= Windows Server 2012 Standard

= Windows Server 2012 R2 Standard

Note: Make sure that you install the English versions of these operating systems.
Oracle Database Software:

= Oracle Client 12¢c Release 1 (12.1.0.2)

Note: Make sure, only one version of Oracle Client is installed on the server. Argus
Insight Installer will not work in case there are multiple versions of Oracle Client are
installed on the same machine.

= Oracle Data Provider 12¢ Release 1 (12.1.0.2) for .Net

Hardware Requirements:

= Up to 5000 cases in the system: 2x2.6 GHz processors, 4 GB memory

= More than 5000 cases in the system: 4x2 GHz processors, 8 GB memory
Additional Software Requirements:

s Dotnet Framework 3.5 Service Pack 1

= IIS 8 (Windows 2012)

= IIS 8.5 (Windows 2012 R2)

= Java Development Kit (JDK) version 1.8

= Microsoft Visual C++ 2005 SP1 Redistributable Package MFC Security Update
= Microsoft Visual C++ Redistributable for Visual Studio 2012 Update 4 (x86)
=  MSXML 6.0

= WebGate 10.1.4.3 (optional)

= WebCenter (deprecated)—While upgrading, in the Components List, if this option
appears, then uncheck it.

Note: Argus Insight Supports SMTP and SMTPS with TLS 1.2 (Forced). SMTPS Supports
both Implicit and Explicit Modes..

1-4 Oracle Argus Insight Installation Guide



Software and Hardware Requirements

Table 1-2 (Cont.) Argus Insight Software and Hardware Requirements

Component

Requirements

Database Server

Operating System as certified by the Oracle Database version.
Oracle Database Software:

= Oracle Database Server (Enterprise Edition/Standard Edition 2 (SE2)) 12¢ Release 1
(12.1.0.2)

(both CDB/PDB and Non-CDB formats)
Oracle Advanced Security Transparent Data Encryption* (Optional)
Oracle Advanced Security Network Encryption (Optional)

*Note: Oracle Database TDE feature is part of the Oracle Advanced Security option
available for Oracle Database Enterprise Edition 12¢

http://www.oracle.com/technetwork/database/options/advanced-secur
ity/index.html

TDE provides the capability to encrypt sensitive data in the Oracle Database in a
manner that is transparent to applications.

Argus Insight product has been functionally certified with tablespace level
encryption using the Oracle Database TDE feature.)

= Oracle RAC 12c Release 1 (12.1.0.2)
= Exadata 12c Release 1 (12.1.0.2)

Note: Oracle database Standard Edition 2 (SE2) is supported for single tenant
deployment only.

Hardware Requirements:
= Up to 5000 cases in the system: 2x2 GHz processors, 4 GB memory
= More than 5000 cases in the system: 4x2 GHz processors, 16 GB memory

Oracle Business
Intelligence Enterprise

Operating System as certified by the OBIEE/BIP.

Oracle Database Software:

Edition (OBIEE)
or = Same as Database Server.
BI Publisher (BIP) ~ 10°l Version:
= OBIEE or BIP 12¢ (12.2.1.0)
Note: You can either install OBIEE or the stand alone BI Publisher (Dashboards are not
available with standalone BI Publisher).
Additional Software Requirements:
= Java Development Kit (JDK) version 1.8
= OBIEE Administrator Tool 12¢ (12.2.1.0) must be installed for configuring the
repository file (RPD).
Note that if you install OBIEE on a Linux machine, you need to install Oracle
Business Intelligence Developer Client tools on a Windows machine. It will include
the BI Administration tool.
Refer to the Oracle OBIEE Installation Manual for further hardware and software
requirements.
= WebGate 11.1.2.2 (optional)
BusinessObjects Operating System as certified by the BusinessObjects.
Server

Oracle Database Software: Oracle Client 12 ¢ Release 1 (12.1.0.2) (with SQL Plus, SQL
Loader, Oracle and OLEDB Objects)

Hardware Requirements: Same as the Argus Insight Web Server
Reporting Tool:

= BusinessObjects XI Release 4.0 Service Pack 6 (only for single tenant installations)
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Important Installation Information

Table 1-2 (Cont.) Argus Insight Software and Hardware Requirements

Component

Requirements

Cognos Server

Operating System as certified by Cognos.

Oracle Database Software: Oracle Client 12 c Release 1 (12.1.0.2) (with SQL Plus, SQL
Loader, Oracle and OLEDB Objects)

Hardware Requirements: Same as the Argus Insight Web Server
Reporting Tool:

= Cognos 10.2.x BI Server (default installation with all components except Cognos
Content Database)

= Cognos 10.2 BI Modeling (default installation with all components)
Additional Software Requirements:
= WebGate 10.1.4.3 (32 bit) (optional)

Argus Insight Client

Supported Operating Systems:

= Windows 10

=  Windows 8.1

= Windows 7

(Supports both 32 and 64 bit)

Hardware Requirements:

= 2.0 GHz Minimum, 1 GB Memory
Additional Software Requirements:

= Adobe Acrobat Reader 11 or DC

= Microsoft Excel: Any version of MS Office. Preferred versions: 2016, 2013 or 2010.
= Microsoft Internet Explorer 11 (32 or 64 bit)

Note: Argus Insight also supports:
s Oracle Identity Manager 11.1.2.2
s Oracle Virtual Machine Server 3.2.10 (64 bit)

1.3 Important Installation Information

Before installing Argus Insight, review the information in this section carefully. You
may need to modify several settings or install required software before you install the
Argus Insight application.

1.3.1 Installation Requirements for the Servers

For the Argus Insight Web Server, BI Publisher, BusinessObjects Server, or Cognos
Server:

Installation Language — You must install all software with the language setting
configured to English. For example, if Oracle is installed in a language other than
English, the registry entries are created with different names. Therefore, to avoid
errors, install all software in English.

Oracle Client — You must install the Oracle client with the default ORACLE_
HOME name, provided by the Oracle Universal Installer. Failure to do so will
display an error message, stating that the Oracle OLE DB provider was not found
during installation.

1-6 Oracle Argus Insight Installation Guide



Important Installation Information

s Time Zone — You must set all servers to the same time zone.

s Default Language Setting — All the servers must have the default language
setting enabled for US English.

To enable US English as the default language setting:
1. Open the Microsoft System Registry Editor.
a. Click Start.
b. Select Run.
c. Enter regedit, and then click OK.
2. Navigate to the following folder:
HKEY_USERS\.DEFAULT\Control Panel\International
3. Double-click the sCountry key in the right pane.
a. In the Value data field, enter United States.
b. Click OK to save changes.
4. Exit from the Registry Editor.

5. Restart the server to reflect the changes.

Additional Notes:
n  For Argus Insight Web Server:

= Install the Oracle client after you install the Dotnet Framework.

= Ensure that either you have disabled the firewall or you have added the Argus
Insight port number in the Windows Firewall Exception list. The default port
number for Argus Insight is 8084.

s For BI Publisher:

= Ensure that you have disabled the firewall. Alternatively, if the firewall is
enabled, ensure that BI Publisher is accessible from other machines on the
network.

s For BusinessObjects Server:

= Ensure that you have disabled the firewall. Alternatively, if the firewall is
enabled, ensure that BusinessObjects is accessible from other machines on the
network.

s For Cognos Server:

=  Ensure that you have disabled the firewall. Alternatively, if the firewall is
enabled, ensure that Cognos is accessible from other machines on the network.

1.3.2 Installation Requirements for the Argus Insight Client

To run the Argus Insight application, you must configure the following settings on the
Argus Insight client machine:

= Add the Argus Insight URL to the trusted sites.
= Enable Cookies to the lowest possible security level.

= Enable Javascript.
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Important Installation Information

s Enable the Allow script-initiated windows without size or position constraints
setting in Internet Explorer.

To enable this setting:

1.

o g & 0 b

Start Internet Explorer.

Open the Tools menu, and select Internet Options.
Select the Security tab.

Click Custom level.

Scroll to the Miscellaneous settings.

Enable the Allow script-initiated windows without size or position
constraints setting.

Click OK to save changes.

1.3.3 General Installation Notes and Information

s All the information about LDAP, Single Sign-On Header, and SMTP configuration
will be synchronized in real-time and also by ETL.

= Ensure that you have configured the Argus Safety URL in the Argus Safety Load
Balancer Server.

To do so:

1.

Navigate to Argus Console, System Management (Common Profile
Switches), and select Network Settings.

In the Argus Safety Load Balancer Server text box, enter either the Argus
Safety URL or the Argus Safety Load Balancer URL.
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Installing Argus Insight

This chapter explains how to use the installation wizard to install Argus Insight,
including the application software and standard reports.

2.1 Before You Install the Argus Insight Application

Before you begin to install the Argus Insight application, you must verify or obtain the
following information:

1. Requirements—Read Section 1.2, "Software and Hardware Requirements" and
verify that your system meets the minimum requirements.

2. Database Instance—Verify that the Argus Insight database instance has been
created and that it is running. In addition, verify that the database has been
created using the character set of your Argus Safety database.

3. Cryptographic Key—Log in to the Argus Safety Web Server. Copy the
UserCryptoKey from the ArgusSecureKey.ini file located at C:\Windows. You
need to specify this key during the installation of Argus Insight.

4. Security—Log in to the Argus Insight Web Server.

a. Ensure that the IUSR user or the user configured in Internet Information
Services (IIS) has sufficient privileges for running the Argus Insight
application. See the Oracle Arqus Insight Minimum Security Configuration Guide
for more information.

b. Ensure that the ASP and ASP.Net extensions are enabled in IIS.

2.2 Installing Argus Insight Components onto the Web Server

Note: If you are upgrading Argus Insight from 8.1 to Argus Insight
8.1.1, first uninstall the application using Argus Insight application,
and then run the Argus Insight 8.1.1 Installer.

To uninstall the existing application, see Section 12, "Uninstalling the
Argus Insight Application".

To run the installation wizard and install the Argus Insight components onto the Web
Server:

1. Download the Argus Insight software from Oracle E-delivery and copy the
software to the Argus Insight Web Server.

2. Login to the Argus Insight Web Server as a user with administrator privileges.
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10.

11.

12.
13.

14.

15.

Click setup.exe.

The Welcome screen of the installation wizard appears.

Click Next to continue.

Enter your user name and company name into the appropriate fields.
Click Next to continue.

The Select Features dialog box appears.

Clear any feature that you do not want to install. By default, the wizard installs all
features.

Click Next to continue.

The Choose Destination Location dialog box appears.

Specify the folder where the system installs the Argus Insight application.
s Toinstall into the default folder (C:\Program Files\Oracle), click Next.

s Toinstall into a different folder, click Browse, select another folder, and then
click Next.

A message appears stating that the wizard is ready to install the Argus Insight
files.

Click Install to start the installation.

A message appears stating that Argus Insight is configuring your new software
along with the progress bar.

Enter the name of the host database server where the Argus Insight data mart is
located, and click Next.

Enter the instance name for the Argus Insight data mart, and click Next.

Enter the database port number you want to assign to the Argus Insight database,
and click Next.

The system updates the TNSNAME.ORA file with the information as specified.
When the update is done, the Cryptographic Key dialog box appears.
Enter the cryptographic key for Argus Insight, and then click Next to continue.

Note: The cryptographic key is in the ArgusSecureKey.ini file located
at C:\Windows on the Argus Safety Web Server with name as
UserCryptoKey. You should have obtained this key during the
pre-installation tasks.

Enter the password for APR_USER.
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16.

17.
18.

19.

20.

21.

22,

Note: The APR_USER database user provides initial database access
to the application user (APR_APP) of Argus Insight. Make sure that
this password is the same on all machines where any Argus Insight
components are stored.

You will be prompted to create or update this user during installation.
You can modify this password by running the Argus Insight installer
and selecting the Modify option. For information about updating the
APR_USER password, see Section 2.2.1, "Changing the APR_USER
Password."

Click Next to continue.

The Confirm Password dialog box appears.

Re-enter the APR_USER password for verification.

Click Next.

The Port Number dialog box appears.

Enter the port number you want to assign to the Argus Insight website.

The default value is 8084. If you are unsure of the port number, use the default
value.

Click Next.
The Argus Insight application is installed successfully.
Click Finish to exit from the installation wizard.

A confirmation dialog box appears — Argus Insight Install wizard will now reboot
the system. Please save any unsaved work.

Click OK to restart the Argus Insight Web Server.

2.2.1 Changing the APR_USER Password

You need to update the password on the database level and the Argus Insight Web
Server or Cognos Server. The Argus Insight application uses this password to
communicate with the database initially.

Before changing the password for the APR_USER on any Argus Insight Web Server or
Cognos Server:

Stop the Argus Insight service.
Stop IIS on the Argus Insight Web Server.
Stop the IIS and the Cognos service on the Cognos Server.

This is required only when you are using Cognos 10 as your Business Intelligence
tool.

Update the password of APR_USER on database level.

You need to update the password at the database level before you can modify the
password for the Argus Insight Web Server.

You can modify the password for APR_USER on any Argus Insight Web Server or
Cognos Server by running the Argus Insight installer on each server.

To modify the APR_USER password:
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Run setup.exe to start the Argus Insight installer.

The Argus Insight Setup Maintenance dialog box appears.
Select Modify, and click Next.

Select Change the password for APR_USER, and click Next.
Enter the APR_USER password.

The password you enter must be the same password for each server being used by
Argus Insight and must be configured in the Argus Insight database.

Click Next.

A dialog box to confirm new password appears.

Enter the new APR_USER password a second time for verification.
Click Next.

The system updates the password for APR_USER.

2.3 Enabling SSL Support for the Argus Insight Website

1.

2
3.
4

Log in to the Argus Insight Web Server.

Obtain and install the SSL certificate.

Go to IIS Manager.

Select Argus Insight, and select Bindings.

The Site Bindings dialog box appears.

Click Add.

The Add Site Binding dialog box appears.

Enter the following details in the Add Site Binding dialog box:
a. In the Type field, select https.

b. Inthe SSL certificate field, select your security certificate.

c. Click OK.
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Creating the Argus Insight Data
Mart Structure

The Argus Insight data mart structure is created while installing Argus Insight
through Liquibase in silent-mode.

Besides, it also creates a link between the source Argus database and the new Argus
Insight data mart. The Extract Transform and Load (ETL) process uses this link to
transfer data from Argus Safety database to the Argus Insight data mart for reporting
purposes.

Liquibase is a refactoring tool that enables Argus Insight to be in synchronization with
the closest major release, and subsequently upgrades the product to the required
minor versions of the product.

Note: The Argus Insight database must be created with the same
character set as the Argus Safety database. Make sure you have
installed the requisite software as per Section 1.2, "Software and
Hardware Requirements".

3.1 Before You Run the Argus Insight Installation

The GLOBAL_NAMES and NLS_LENGTH_SEMANTICS database parameters must
be configured properly in order for the Argus Insight installation to run. You must
check those settings before you run the Argus Insight Installation. If the parameters are
not set properly, the installation will fail.

To review and modify these database settings:
1. Contact your database administrator (DBA).

2. Verify that the database configuration file for the Argus Insight database defines
the following database parameter values:

»  GLOBAL_NAMES = FALSE

(This parameter must be set to FALSE for Argus Insight to be able to create the
database links.)

= NLS_LENGTH_SEMANTICS = CHAR

= TNS Name for Argus Safety Database must be present in the Oracle Database
Client > tnsnames.ora file at the following path:

.. \network\admin\tnsnames.ora

3. Restart the database instance to reflect the changes.
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To create a DBA user:

To use a different user than SYSTEM user to execute the installation, then create a DBA

user by executing the DBA User Creation script:

ArgusInsight\ Database\ D Blnstaller\ Utilities\ Create_Dba_User\ai_create_dba_user.bat

For more details on creating this user, see Section 3.4.3, "Creating the DBA User."

Besides creating the DBA user, this batch file also provides minimum necessary

privileges required for executing the installation.

3.2 Modify of the dbinstaller.properties file

Open the DBInstaller\dbinstaller.properties file, and view or modify the following

parameters to make sure that Liquibase runs properly.

Parameter Description Modify Default or Sample Value
db_connect_string Database instance details in ~ Yes db_connect_string
the form of I .
<host>:<port>/<SID> =abc.in.oracle.com:1521/811DB
dba_user Name of the Target Yes dba_user=ai_dba_user
Database DBA user
log_level Log level setting related to ~ Yes log_level=info
liquibase for smooth run.
Possible values:
= DEBUG
= INFO
argus_securekey_path Complete directory path of  Yes argus_securekey_
Argus Secure Key ini file on path=c:/windows
the middle-tier.
appschema_mart_user Argus Insight Mart schema  No appschema_mart_user=apr_
Owner mart/pwd
.appschema_stage_user Argus Insight Staging Yes appschema_stage_user=apr_
schema Owner stage/pwd
appschema_ai_link_user Argus Insight Link User Yes appschema_mart_hist_user=apr_
hist/pwd
appschema_rls_user Argus Insight VPD schema  Yes appschema_ai_link_user=apr_
Owner link/pwd
appschema_mart_app_user Argus Insight Application ~ Yes appschema_rls_user=rls_
schema Owner user/pwd
appschema_mart_hist_user Argus Insight History Yes appschema_mart_app_user=apr_
schema Owner app/pwd
appschema_ai_apr_user Argus Insight apr User No appschema_ai_apr_user=apr_
Name user/pwd
appschema_ai_login_user  Argus Insight Login User Yes appschema_mart_user=apr_
Name mart/pwd
ai_role Argus Insight Mart Role Yes ai_role=MART_ROLE
ai_app_role Argus Insight Mart App Yes ai_app_role=APP_ROLE
Role
ai_link_role Argus Insight Mart Link Yes ai_link_role=LINK_ROLE
Role
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Parameter

Description Modify

Default or Sample Value

safety_db
safety_ro_user

#Default Datafiles Directory

#Insight Stage Normal
Datafiles

#Insight Stage ESM
Datafiles

#Insight Stage WHO
Datafiles

Argus Safety database Yes
instance name

Argus Insight read only user Yes
in Safety DB

Default location of the Yes
datafiles. on the Database
Server

Location of Argus Insight Yes
normal datafiles.

Location of Argus Insight Yes
ESM datafiles.

Location of Argus Insight Yes
WHO datafiles.

safety_db=AS_DBA_
USER/pwd@SAF811DB

safety_ro_user=insight_ro_user

default_datafile_destination
=<c:/app/oradata/811DB>

= ai_stage_data_01=APR_
STAGE_DATA_01

= ai_stage_data_01_
datafile=APR_STAGE_
DATA_01.DBF

= ai_stage_ind_01=APR_
STAGE_INDEX_01

= ai_stage_ind_01_
datafile=APR_STAGE_
INDEX_01.DBF

= ai_stage_lob_01=APR_
STAGE_LOB_01

= ai_stage_lob_01_datafile
=APR_STAGE_LOB_01.DBF

= apr_sesm_data_01=APR_
SESM_DATA_01

m apr_sesm_data_01_
datafile=APR_SESM_DATA _
01.DBF

= apr_sesm_ind_01=APR_
SESM_INDEX_01

= apr_sesm_ind 01_
datafile=APR_SESM_INDEX_
01.DBF

= apr_sesm_lob_01=APR_
SESM_LOB_01

= apr_sesm_lob_01_
datafile=APR_SESM_LOB_
01.DBF

= stage_who_01=APR_
SWHOC_DATA_01

= stage_who_01_datafile=APR_
SWHOC_DATA_01.DBF
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Parameter

Description Modify

Default or Sample Value

#Insight Mart Case/Rpt
Datafiles

#Insight Mart
Non-Case/Rpt Datafiles

#Insight Mart EDM
Datafiles

#Insight Mart WHO
Datafiles

Location of Insight Mart Yes
case and report datafiles.

Location of Insight Mart Yes
non-case and report
datafiles.

Location of Insight Mart Yes
EDM datafiles

Location of Insight Mart Yes
WHO datafiles
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mart_case_rpt_data_
01=APR_MCAS_DATA_01

mart_case_rpt_data_01_
datafile=APR_MCAS_DATA_
01.DBF

mart_case_rpt_ind_01=APR_
MCAS_INDEX_01

mart_case_rpt_ind_01_
datafile=APR_MCAS_
INDEX_01.DBF

mart_case_rpt_lob_01=APR_
MCAS_LOB_01

mart_case_rpt_lob_01_
datafile=APR_MCAS_LOB_
01.DBF

mart_non_case_data_
01=APR_MCFG_DATA_01

mart_non_case_data_01_
datafile=APR_MCFG_DATA_
01.DBF

mart_non_case_ind_01=APR_
MCFG_INDEX_01

mart_non_case_ind_01_
datafile=APR_MCFG_
INDEX_01.DBF

mart_non_case_lob_01=APR_
MCFG_LOB_01

mart_non_case_lob_01_
datafile=APR_MCFG_LOB_
01.DBF

mart_edm_data_01=APR_
MEDM_DATA_01

mart_edm_data_01_
datafile=APR_MEDM _
DATA_01.DBF

mart_edm_ind_01=APR_
MEDM_INDEX_01

mart_edm_ind_01_
datafile=APR_MEDM _
INDEX_01.DBF

mart_edm_lob_01=APR_
MEDM_LOB_01

mart_edm_lob_01_
datafile=APR_MEDM_LOB_
01.DBF

mart_who_01=APR_
MWHOC_DATA_01

mart_who_01_datafile=APR_
MWHOC_DATA_01.DBF



Modify of the dbinstaller.properties file

Parameter Description Modify Default or Sample Value
#Insight Hist Case/Rpt Location of Argus Insight Yes = hist_case_rpt_data_01=APR_
Datafiles case or report History MCAS_HIST _DATA_01

datafiles

#Insight Hist Non-Case/Rpt Location of Argus Insight Yes

Datafiles

#Insight Apr Datafiles

Default and Temporary
tablespaces

Tablespace Encryption

non-case and report History
datafiles.

Location of Argus Insight Yes
APR datafiles

Defines default and Yes
temporary tablespace name

Specifies the logic used for ~ Yes
default encryption

s hist_case_rpt_data_01_
datafile=APR_MCAS_HIST_
DATA_01.DBF

= hist_case_rpt_ind_01=APR_
MCAS_HIST_INDEX_01

s hist_case_rpt_ind_01_
datafile=APR_MCAS_HIST_
INDEX_01.DBF

= hist_case_rpt_lob_01=APR_
MCAS_HIST_LOB_01

= hist_case_rpt_lob_01_
datafile=APR_MCAS_HIST_
LOB_01.DBF

= hist_non_case_data_01=APR_
MFACT_HIST_DATA_01

s hist_non_case_data_01_
datafile=APR_MFACT_HIST_
DATA_01.DBF

s hist_non_case_ind_01=APR_
MFACT_HIST_INDEX_01

s hist non_case_ind_01_
datafile=APR_MFACT_HIST_
INDEX_01.DBF

s hist_ non_case_lob_01=APR_
MFACT_HIST_LOB_01

s hist_ non_case_lob_01_
datafile=APR_MFACT_HIST_
LOB_01.DBF

= apr_user_data_01=APR_
USER_DATA_01

= apr_user_data_01_
datafile=APR_USER_DATA _
01.DBF

= apr_user_ind_01=APR_
USER_INDEX_01

= apr_user_ind_01_
datafile=APR_USER_INDEX_
01.DBF

= apr_user_lob_01=APR_
USER_LOB_01

= apr_user_lob_01_
datafile=APR_USER_LOB_
01.DBF

s default_ts=USERS
= temp_ts=TEMP

= No encryption—Blank

= Encryption done—Text like
encryption using 'AES256'
default storage (encrypt)
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Parameter Description Modify Default or Sample Value
Tablespace Parameters Specifies the details of the ~ Yes = tablespace_initial_size=10M
tablespace

= tablespace_autoextend=ON
= tablespace_next_size=10M

= tablespace_block_size=8K

LOB Storage Location of Argus Insight Yes lob_storage=basicfile
LOB storage.

Possible Values:
= basicfile

= securefile

3.3 Argus Insight Configuration Requirements

3.3.1 Database Parameters

Table 3-1 lists the database parameters and the values that must be set for Argus
Insight.

For those parameters that require a numeric value, Table 3-1 lists the minimum value
recommended. You may need to increase the value depending on your system
configuration and the number of cases. It is the responsibility of the database
administrator to monitor the system and adjust the database parameters as necessary.
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Table 3—1

Database Parameters for Argus Insight

Database Parameter

Required Value

COMPATIBLE (for Oracle 12c R1)

12.1.0.2 or later

CURSOR_SHARING

EXACT

GLOBAL_NAME

FALSE

JOB_QUEUE_PROCESSES

10 (Minimum value recommended)

NLS_LENGTH_SEMANTICS CHAR
OPTIMIZER_MODE ALL_ROWS
OPTIMIZER_SECURE_VIEW_MERGING TRUE

PARALLEL_MAX_SERVERS

Minimum value recommended based on the total number of cases:
= Small (< 30,000 cases): 16

= Medium (30,000 to 200,000 cases): 32

= Large (200,000 to 1,000,000 cases): Default

= Extra Large (> 1,000,000 cases): Default

PGA_AGGREGATE_TARGET

Minimum value recommended based on the total number of cases:
= Small (< 30,000 cases): 0.5 GB

= Medium (30,000 to 200,000 cases): 2 GB

= Large (200,000 to 1,000,000 cases): 3 GB

= Extra Large (> 1,000,000 cases): 4 GB

QUERY_REWRITE_ENABLED

TRUE (if computing statistics regularly)
FALSE (if not computing statistics regularly)

SGA_MAX_SIZE

Greater than or equal to the value of the SGA_TARGET parameter.

SGA_TARGET

Minimum value recommended based on the total number of cases:
s Small (< 30,000 cases): 1 GB

= Medium (30,000 to 200,000 cases): 2.5 GB

= Large (200,000 to 1,000,000 cases): 3.5 GB

= Extra Large (> 1,000,000 cases): 4.5 GB

The 32-bit architecture allows for 4 GB of physical memory to be
addressed. DBAs should verify the maximum addressable RAM for
their respective architectures.

UNDO_MANAGEMENT

AUTO

WORKAREA_SIZE_POLICY

AUTO

DB_BLOCK_BUFFERS (in MB) /
DB_CACHE_SIZE

Leave set to the Oracle default value

DB_BLOCK_SIZE (in bytes)

Leave set to the Oracle default value

QUERY_REWRITE_INTEGRITY

Leave set to the Oracle default value

SHARED_POOL_SIZE

Leave set to the Oracle default value
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3.3.2 Database I/0 Configuration

Table 3-2 Recommended Database I/O Configuration for Argus Insight

Total Number of Cases

Small Medium (30,000 Large (200,000 Extra Large
Database I/0 Configuration (< 30,000) to 200,000) to 1,000,000) (> 1,000,000)
Number and Size of Redo Log Files  Default 3 X 500 MB 5 X500 MB 5 X 500 MB

The value depends on the characteristics of the I/O subsystem such as the
I/0 bandwidth, storage disks type, and RAID level. (Oracle recommends
RAID 1+0 or similar.)

TEMP Tablespace Size

32GB 32GB 64 GB 128 GB

UNDO Tablespace Size

16 GB 32GB 64 GB 128 GB

The recommended UNDO tablespace size is based on the projections with
the following two parameter values:

RETENTION=NOGUARANTEE
UNDO_RETENTION=900 (seconds)

3.3.3 Recommended Configuration for the Database Server

Table 3-3 Recommended Configuration for the Argus Insight Database Server

Total Number of Cases

Database Server

Medium (30,000 Large (200,000 Extra Large

Configuration Small (< 30,000) to 200,000) to 1,000,000) (> 1,000,000)

RAM 4-8GB 8-16 GB 16-32 GB 16-32 GB

CPU Equivalent to 24 Equivalent to 4-8 Equivalent to 8-12  Equivalent to 8-12
Dual Core, 3 GHz Dual Core, 3 GHz Dual Core, 3GHz  Dual Core, 3 GHz

Note:

The Argus Insight Database and Argus Safety Database TNS

names entry must be available in both Argus Insight Database Server
and Argus Safety Database Server. Argus Safety Database TNS should
also be present in the Argus Insight Web Server.

3.4 Creating Argus Insight Database Schema

3.4.1 Pre-requisites

Make sure:

= an Oracle client with Administrator option is installed on the server.

= database TNS entry should be added in the TNSNAMES.ora file.

= loadjava should be working on the machine.

From the command prompt, execute loadjava.

= Java 1.8 or higher must be installed and Java Cryptography Extension (JCE)
Unlimited Strength Jurisdiction Policy Files 8 is applied.
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Note that the Liquibase installer supports both JRE 32 and 64 bit.

login machine user should have administrative privileges.

To install Java:

1.

Download the jce_policy-8.zip file on your local machine from the following link:

http:/fwww.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
(download jce_policy-8.zip).

Unzip the jce_policy-8.zip.

Replace local_policy.jar and US_export_policy.jar files present in all the Java JRE
and JDK installation security folder with the local_policy,jar and US_export_
policy.jar shipped in jce_policy-8.zip.

For example:

Location of Java JRE and JDK 32-bit.

C:\Program Files (x86)\Java\jre1.8.0_121\lib\security

C:\Program Files (x86)\Java\jdk1.8.0_121\jre\lib\security

Or, you may install both JRE and JDK 64-bit. To do so, perform the same steps.
From the command prompt verify that Java is properly installed by executing:
java -version

If no Java version appears, check the environment variables settings and path
system variables have correct Java installation path set.

To set Java Installation Path:

1.

Right-click the My Computer (or Computer) icon, and from the drop-down menu
select Properties.

From the left-pane, select Advanced system settings.

The System Properties dialog box with Advanced tab appears.

In the Startup and Recovery section, click Environment Variables...

From the System variables section, scroll-down to Path variable, and double-click.
The Edit System Variable dialog box appears.

In the Variable value: field, enter the location where Java will be installed, and end
it with a semi-colon (;).

Click OK to close the Edit System Variable dialog box.
Click OK to close the System Properties dialog box.

3.4.2 Creating Users and Roles in the Argus Safety Database

1.

To create the Safety Read-only user for Insight, execute the following script from
the folder DBInstaller\ Utilities\Create_Safety_Ro_User:

»  For Windows—Use the batch script ai_argus_read_only{user}.bat
s For Linux—Use the shell script ai_argus_read_only{user}
When prompted, enter the following parameters:

= Name of the Safety Database instance
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= Name of DBA User in Safety Database

= DBA user password in Safety Database

= Name of the Safety Read Only User to be created for Insight

= Password of the Safety Read Only User

= Role to be associated with Safety Read-only User

s Default Tablespace for Safety Read-only User—For example, USERS

s Temporary Tablespace for Safety Read-only User—For example, TEMP
The process of creating a Safety Read-only user begins.

Review the log file from the following path, and check for any errors, when a
confirmation message appears.

C:\Program Files (x86)\ Oracle\ ArgusInsight\ Database\ DBInstaller\ Utilities\ Create_
Safety_Ro_User\AI_AS_RO_User_MMDDYYYY_ HH24MISS.log

3.4.3 Creating the DBA User

Note: You must execute this script to install Argus Insight database,
even if you are using the SYSTEM user. This script provides additional
grants to the existing user.

To create a DBA user that has privileges same as the SYSTEM user for installation:

1.

Execute the following script from the folder DBInstaller\ Utilities\Create_Dba_
User:

s For Windows—Use the batch script ai_create_dba_user.bat

s For Linux—Use the shell script ai_create_dba_user

When prompted, enter the following parameters:

= Argus Insight Database instance name

= SYSoran equivalent SYSDBA user on this database

= SYSDBA user password

= Name of the DBA User—For example, SYSTEM or AI_DBA_USER
= DBA user password

If you provide a non-existing user name, then the script creates this as a new user,
and provides the necessary grants to this user.

If you provide an already existing user name, then the script provides the
necessary additional grants to the existing user.

When done, a message appears as:

Created DBA user &dba_user

Press Exit.

Verity the log files for status information from:

C:\Program Files (x86)\Oracle\ ArgusInsight\ Database\ DBInstaller\ Utilities\ Create_
Dba_User\AI_DBA_User_ MMDDYYYY_HH24MISS.log
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Recommendation: For security reasons, Oracle recommends to drop
the DBA user from the database after successful installation of Argus
Insight as this user will have DBA privileges.

To drop this user, connect to the respective database as a privileged
user, and execute the following command:

DROP USER <INSTALL_USER> CASCADE;

3.4.4 Creating Fresh Argus Insight Schema
1. Log in to the Argus Insight Web Server.

2. Navigate to Programs > Oracle > Argus Insight > Database > DBInstaller.
3. Open Dbinstaller\dbinstaller.properties file.
4. Modify the following parameters:
s Insight Database:
- db_connect_string—connects to the Argus Insight database.
Syntax: db_connect_string=<host>:<port>/<SID>
For example, server.us.xx.com:1521/AI811MT

- dba_user—specifies the name of the DBA user to run Argus Insight
Liquibase Install.

See Section 3.4.3, "Creating the DBA User.".

— default_datafile_directory—default location on the database server, where
datafiles will be created.

= Insight User of each schema, where password is optional:
- appschema_mart_user
- appschema_stage_user
- appschema_mart_app_user
— appschema_mart_hist_user
— appschema_ai_link_user

— appschema_rls_user

appschema_ai_apr_user

appschema_ai_login_user
= Insight Roles:
- ai_role—specifies Mart User roles
- ai_app_role—specifies App User roles
- ai_link_role—specifies Link User roles
= Secure Key:

- argus_securekey_path—path of the file insight.ini in the middle-tier
machine from where the DBInstaller.bat is executed.

= Safety Database:

- safety_db—Argus Safety database instance name
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- safety_ro_user—Argus Insight Read-only user created in Argus Safety

Note: For more information on these parameters, see Section 3.2,
"Modify of the dbinstaller.properties file."

It is recommended that you preserve the default names for tablespaces
and roles.

5. From the command prompt, go to DBInstaller directory.
6. Type dbinstaller.bat, and press Enter.

The Liquibase install begins, and the parameters (as entered) appear on the
command prompt screen with password in the hidden mode (****).

7. Keep monitoring the Liquibase progress by querying the Liquibase Log table
insight_dbchangelog, created in APR_MART schema.

8. When the process is complete, a confirmation message appears with the latest
version of Argus Insight.

The following is created as per the values specified in the dbinstaller.properties
file:

n  Users
- MART_USER
- STAGE_USER
- MART_APP_USER
- MART_HIST_USER
— AL LINK_USER
- RLS_USER
- AI_APR_USER
- Al LOGIN_USER
= Roles
- AL ROLE
- AI_APP_ROLE
- AL LINK_ROLE
s Factory Data

—  Out of the box Factory data is loaded into tables such as ETL_
PROCEDURES, CMN_PROFILE_GLOBAL, etc.

s Database Links, DB_LINK_ARGUS:
—  From STAGE_USER of Argus Insight to ARGUS_APP of Safety
— From MART_USER of Argus Insight to ARGUS_APP of Safety
— From MART_APP_USER of Insight to ARGUS_APP of Safety

= Tablespaces

Note that the tablespace names begin with APR. The Argus Power Reports
(APR) product was renamed to Argus Insight.
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STAGE Schema
Tablespaces

MART Schema
Tablespaces

HIST Schema
Tablespaces

APR User
Tablespaces

APR_STAGE_DATA_
01

APR_STAGE_INDEX_
01

APR_STAGE_LOB_01
APR_SESM_DATA_01
APR_SESM_INDEX_
01

APR_SESM_LOB_01

APR_SWHOC_
DATA_01

APR_MCAS_DATA_
01

APR_MCAS_INDEX_
01

APR_MCAS_LOB_01

APR_MCFG_DATA_
01

APR_MCFG_INDEX_
01

APR_MCFG_LOB_01

APR_MEDM_DATA _
01

APR_MEDM_
INDEX_01

APR_MEDM_LOB_01

APR_MWHOC_
DATA_01

APR_MCAS_HIST_
DATA_01

APR_MCAS_HIST_
INDEX_01

APR_MCAS_HIST_
LOB_01

APR_MFACT_HIST_
DATA_01

APR_MFACT_HIST_
INDEX_01

APR_MCFG_HIST_
LOB_01

APR_USER_DATA_01

APR_USER_INDEX_
01

APR_USER_LOB_01

9. Press Exit.

3.4.5 Validating the Schema

1. Navigate to Database > DBInstaller > ValidateSchema.

2. Run the batch script validate_schema.bat.

3. When prompted, enter the following parameters:

= Enter instance name: <Argus Insight Database Instance name>

= Enter DBA User Name: <DBA user of Argus Insight>

=  Enter Password for DBA User: <DBA User password in Argus Insight>

s Enter Validation Data File Name: The validation control file name (without the
.CTL extension)

For example, VLDN_APR_AI 8.1.1

= Enter the destination where the log file is to be placed:

<C:\AI_811\Database\ DBInstaller\ ValidateSchema>

= Enter the log file name for recording the schema differences:

<VLDN_APR_AI_8.1.1_diff log>

= Enter Validation Output File Name: The validation output file name to record
the validation progress:

<VLDN_APR_AI_8.1.1.log>
4. Enter the password for the Argus Insight SYSTEM or DBA user, and press Enter..

5. When the validation process is complete, a confirmation message appears.
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The log files are created at the following location:

C:\Program Files (x86)\Oracle\ ArgusInsight\ Database\ DBInstaller\ ValidateSchema\

To view any schema discrepancies, such as missing objects, use the Difference
Log File.

To view the list of errors, which occurred during schema validation, use the
Output Log File.

Note:

» If Argus Insight read-only user is created, then ignore the schema
validation differences, where

- Objects are RO% views/columns
- GRANTEE is Argus Insight Read-only user

= If Argus Insight and Argus Mart are installed on the same
Database server, ignore the differences due to grants from APR_
MART/RLS_USER of Insight to AM_MART_USER/AM_APP_
USER of Argus Mart.

3.4.6 Creating Argus Insight Read-only User
1. Open DBInstaller\ Utilities\ Create_Insight Ro_User file.

For Windows—execute the batch script ai_ ro_user.bat

For Linux—execute the shell script ai_ ro_user

2. When prompted, enter the following parameters:

Enter TNSNAME Entry to connect to the ARGUS INSIGHT Database: <
ARGUS INSIGHT Database name>

Enter the name of Custom DBA user in Insight Database: < Argus Insight
Install user>

Enter password for install user in Insight Database: <Install user password>
Enter Mart schema owner name in Insight Database: <Mart User of Insight>

Enter Argus Insight History schema owner name in Insight Database: <Mart
Hist User of Insight>

Enter Read Only user to be created in Insight Database: <Read-only user to be
created in Insight>

Enter password for Read Only user of Insight Database: <Insight Read-only
user password>

3. DPress Exit.

4. Verity the log files for status information from:

DBlInstaller\Utilities\ Create_Insight_Ro_User\AI_RO_User_MMDDYYYY_
HH24MISS.log

3.5 Creating Database Links
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3.5.1 From Argus Safety to Argus Insight Database

This link allows real-time updates of some of the values from Argus Console to Argus
Insight data mart.

1.

Create the reverse DB Link by executing the script file from
DBInstaller\Utilities\ Database_Links\argus_to_mart.

s For Windows—execute the batch script ai_argus_db_link_setup.bat

s For Linux—execute the shell script ai_argus_db_link_setup

When prompted, enter the following parameters:

= Enter the Argus Safety Database Tns Name: <Safety Database Instance Name>

= Enter the name of Argus Safety schema owner in Safety Database Instance:
<user account that owns the Argus Safety schema>

= Enter the password for Argus Safety schema owner: <password of Argus
Schema owner>

= Enter the name of Argus Safety Role: < Argus Safety role>

= Enter the name of Read only Role in Safety Database: <Insight Read-only role,
created in Argus Safety>

= Enter the Argus Insight Database Tns Name: <Argus Insight database>
= Enter the name of link user in Insight Database.: <link user of Argus Insight>
= Enter the password for user Link user: <link user password>

Verify that the script is successfully connected as <Safety schema owner/Safety
schema password>@<Argus Safety Database Name>, and press Enter.

When the confirmation message appears, press Enter.
Verity the log files for status from:

DBlnstaller\ Utilities\ Database_Links\argus_to_mart\ ARGUS_TO_MART_DB_
LINK_MMDDYYYY_HH24MISS.log

3.5.2 From Argus Insight to Argus Safety (manually)

During Fresh installation, the database link from Argus Insight to Argus Safety (DB_
LINK_ARGUS) is created as a part of the installation process. However, you can
manually recreate the link DB_LINK_ARGUS.

1.

2.

Navigate to DBInstaller\ Utilities\ Database_Links\db_link_argus.

= For Windows—execute the batch script ai_create_db_link_argus.bat
s For Linux—execute the shell script ai_create_db_link_argus

When prompted, enter the following parameters:

= Enter the name of the Safety Database instance: <Safety Database Instance
Name>

= Enter the name of the Insight Database instance: <Insight Database Instance
Name>

= Enter the name of DBA User in Insight DB: <Insight dba user>

= Enter the password for user &dba_user: <Insight dba user pwd>
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= Enter the name of the Read Only User in Safety DB: <Safety Read Only user
for Insight>

= Enter the password for Read Only user in Safety: <Read-only user pwd>

= Enter the name of the stage owner in Insight: <Stage user of Insight>

= Enter the password for Stage user: <Stage user password>

= Enter the name of the mart owner in Insight: <Mart user of Insight>

= Enter the password for Mart owner: <Mart user password>

= Enter the name of the mart app owner in &insight_db: <App user of Insight>
= Enter the password for app owner: <App user password>

3. Verify that the script is successfully connected as <Insight DBA user/Insight DBA
user pwd>@<Argus Insight>, and press Enter.

Wait until a message Created DB_LINK_ARGUS appears for each Stage, Mart, and
App user.

4. DPress Exit to close the Insight to Argus Database Link Creation window.
5. Verify the log files for status from:

DBlnstaller\Utilities\ Database_Links\db_link_arqus\DB_LINK_ARGUS_
MMDDYYYY_HH24MISS.log

3.6 Run Initial ETL

1. Navigate to DBInstaller folder.
Double click dbinstaller.exe.
Click Initial ETL.
Enter the parameters, and click OK.
Click Start ETL.

@ o » w N

To monitor the ETL progress, execute query on tables:
» staging data_insert_log
» mart _data_insert_log

For more details on ETL, see Chapter 6, "Extracting, Transforming, and Loading Data."

3.7 Running Additional Grant Scripts for Single DB Instance

If Argus Insight and Argus Mart are running on the same database, provide additional
grants for this database instance.

1. Navigate to DBInstaller\ Utilities\ am_grants.
= For Windows—execute the batch script am_grants.bat
= For Linux—execute the shell script am_grants

2. When prompted, enter the following parameters:

= Enter the TNS name to connect to SDM database: <Argus Insight Database
Instance name>

= Enter the name of dba user in Insight Database: <DBA user of Insight
Database>
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= Enter Password for User install user: <DBA user password>
3. Press Exit when a status message appears as:

Execution of grants from Insight to Mart User and Mart App User completed
4. Verify the log files for status from:

C:\Program Files (x86)\Oracle\ ArgusInsight\ Database\ DBInstaller\ Utilities\am_
grants\AM_GRANTS_MMDDYYYY_HH24MISS.log

Note: After execution of the utility, Argus Insight schema validation
file will reflect additional privileges.
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Upgrading the Argus Insight Data
Mart Structure

Argus Insight upgrade process has been moved from Schema Creation Tool to
Liquibase for silent installation.

Before upgrading, make sure:

In the profile switch CMN_PROFILE_GLOBAL, the existing database version is

1.

2.

8.1.

Take the latest Liquibase build for 8.1.1.

To upgrade Argus Insight data mart structure:

1.
2.
3.

Log in to Argus Insight Web Server.

Navigate to Programs > Oracle > Argus Insight > Database > DBInstaller.

Open DBlInstaller.properties file.

Modify the following parameters:

Insight Database:

db_connect_string—connects to the Argus Insight database.
Syntax: db_connect_string=<host>:<port>/<SID>
For example, db_connect_string=Us. Xx.com:1521/AI811MT

dba_user—specifies the name of the DBA user to run Argus Insight
Liquibase Install.

See Section 3.4.3, "Creating the DBA User."

Insight User of each schema, where password is optional:

appschema_mart_user
appschema_stage_user
appschema_mart_app_user
appschema_mart_hist_user
appschema_ai_link_user
appschema_rls_user
appschema_ai_apr_user

appschema_ai_login_user
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4.1 Post-upgra
1.

= Insight Roles:
- ai_role—specifies Mart User roles
- ai_app_role—specifies App User roles
- ai_link_role—specifies Link User roles
= Secure Key:

- argus_securekey_path—path of the file insight.ini in the middle-tier
machine from where the DBInstaller.bat is executed.

= Safety Database:
- safety_db—Argus Safety database instance name

- safety_ro_user—Argus Insight Read-only user created in Argus Safety

Note: For more information on these parameters, see Section 3.2,
"Modify of the dbinstaller.properties file."

From the command prompt, go to DBInstaller directory.
Type dbinstaller.bat, and press Enter.

The Liquibase upgrade begins, and the parameters (as entered) appear on the
command prompt screen with password in the hidden mode (****).

Keep monitoring the Liquibase progress by querying the Liquibase Log table
insight_dbchangelog, created in APR_MART schema.

When the process is complete, a confirmation message appears with the latest
version of Argus Insight.

de Steps

Validate Schema using the schema validation control file VLDN_APR_AI_
8.1.1.CTL.

See Section 3.4.5, "Validating the Schema."

Recreate the Safety RO User of Insight before execution of the next Incremental
ETL.

See Section 3.4.2, "Creating Users and Roles in the Argus Safety Database."
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Configuring the Argus Insight Application

This chapter provides information about configuring the Argus Insight application
and the Argus Insight scheduling service.

5.1 Logging In to Argus Insight for Configuration and Setup

1.

Log in with rights to a workstation from where you can access the Argus Insight
application.

Start Internet Explorer.
In the Address bar, enter the following URL to start the Argus Insight:
http://Argus_Insight_WebServer Name:port_number/default.asp
Press Enter.
The Argus Insight Login screen appears.
Log in to the Argus Insight application:
a. Inthe User Name field, enter admin.
b. In the Password field, enter the password for the admin user.
This password is the same as the password of the admin user in Argus Safety.

c. Click Login.

Note: If you are using a Single Sign On (SSO) environment, you
must ensure that SSO tools such as OAM are disabled on the Argus
Insight Web Server for initial configuration. The only administrator
user in Argus Insight is a non-LDAP user. A non-LDAP user cannot
log in to Argus Insight with SSO tools set to Enabled.

Note: In case of a multi-tenant setup, you must ensure that the entire
configuration is done using the default enterprise.

= This will help in copying the configuration to a different
enterprise

= All the global configuration is available in the default enterprise.
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5.2 Configuring the Argus Insight Application Profile Switches

Profile switches are a collection of settings that let you configure the default behavior of
the system. This section describes the profile switches that you must set to establish
connectivity with your Business Intelligence tool and to run the initial ETL.

For detailed information about all the profile switches, see:

»  Oracle Argus Insight CMN Profile Enterprise Table Guide (CMN_PROFILE_
ENTERPRISE.pdf)

»  Oracle Argus Insight CMN Profile Global Table Guide (CMN_PROFILE_GLOBAL.pdf)

5.2.1 Accessing and Modifying the Profile Switches

To access and modify the Argus Insight profile switches:

1. Log in to the Argus Insight application.

2. On the Argus Insight home page, from the upper-right corner, click the Tools tab.
The Administration Tools screen appears.

3. Click the List Maintenance tab.

4. From the List Maintenance Items group, select Profile Switches.

The Attributes group is updated with the profile switches that you may configure.

Note: When the Argus Insight Database Source profile switch is set
to Argus Mart, then in the List Maintenance section, only Profile
Switches and Case Series Modification Justification list maintenance
items are available.

For more information on this profile switch, see Section 5.2.4, "Setting
the Attributes Specific ONLY to Argus Mart".

5.2.2 Setting the Populate Data Attributes

You may control data population based on data attributes.

The following is the list of profile switch along with their value required to be set to
populate data attributes.

Table 5-1 Populate Data Attribute-Value set

Attribute Value
POPULATE AFFILIATE 0 — Do not bring any affiliate data into the Insight data mart.
DATA

1 — Bring all affiliate data into the Insight data mart.

POPULATE 0 — Do not bring any interchange data into the Insight data
INTERCHANGE DATA mart.

1— Bring all interchange data into the Insight data mart.

2 — Bring only the SAFETYREPORT, MESSAGES, and EDI_
INFO tables data into the Insight data mart.

POPULATE 0 — Populate configuration data only.
gﬁ"?“EA/ CONFIGURATION 1 — Populate all the data (both case and configuration data).
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Table 5-1 (Cont.) Populate Data Attribute-Value set

Attribute Value
LEGACY REPORTS 0 — Configuration items are not visible.
CONFIGURATION

1— Configuration items are visible.

Note: If Legacy Reports Configuration switch is set to 1, then
legacy reports switches becomes available for obsolete reports,
and you must configure the following switches:

= POPULATE NARRATIVE LANGUAGES TABLE
= COMPANY LOGO PATH

= DAYSTOLOCK

= UDN COLUMN FOR SUPPLIER NAME

= FOLLOW-UP ACTION CODE

= POPULATE DLL SLL REPORTS TABLE DATA

To configure these switches, refer to Argus Insight 7.0.2
Installation Guide.

To set the data attributes:

1. On the Administration Tools screen, click the List Maintenance tab.

2. From the List Maintenance Items group, select Profile Switches.

3. From the Attributes group, select a profile switch, and click Modify.
The Modify Attributes dialog box appears.

Note: See Table 5-1, " Populate Data Attribute-Value set".

4. In the Value field, enter a numeric value, and click OK.

The profile switch is set and you return to List Maintenance tab.

5.2.3 Setting the Email Attributes

You may configure the profile switches that relate to sending and receiving email after
an extract, transform, and load (ETL) operation has completed, as well as sending
email for scheduled reports.

The following is the list of profile switch along with their value required to be set for
email messages and delivery.

Table 5-2 Email Specific Attribute-Value set

Attribute Value

ETL EMAIL SETUP 0 — Send no email message after an ETL operation.
1 — Send an email message only if an initial or incremental ETL
fails.

2 — Send an email message only if an initial or incremental ETL
succeeds.

3 — Send an email message after any initial or incremental ETL
(failure or success).
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Table 5-2 (Cont.) Email Specific Attribute-Value set

Attribute Value
ETL EMAIL RECEIVER Specify the email address of each administrator who should
ADDRESS receive email status messages of the ETL process. Use a

semi-colon to separate each entry.

If the Value field blank, then no email messages are sent.

EMAIL SENDER ADDRESS Specify the email address of each administrator who should
receive email status messages of the ETL process. Use a
semi-colon to separate each entry.

If the Value field blank, then no email messages are sent.

FAILED RECIPIENTS Specify the email address of the user who will receive
STATUS EMAIL ADDRESS information about undeliverable emails.

To configure the attributes related to email messages and delivery:

1. On the Administration Tools screen, click the List Maintenance tab.

2. From the List Maintenance Items group, select Profile Switches.

3. From the Attributes group, select a profile switch, and click Modify.
The Modify Attributes dialog box appears.

Note: See Table 5-2, " Email Specific Attribute-Value set".

4. In the Value field, enter a value, and click OK.

The profile switch is set and you return to List Maintenance tab.

5.2.4 Setting the Attributes Specific ONLY to Argus Mart

Argus Insight supports queries for analysis of the historical case data based on specific
date/time through Argus Mart. To enable access to this data in Argus Mart, you need
to set specific attributes.

The following is the list of profile switch along with their value required to be set to
populate Argus Insight data into Argus Mart database.

Table 5-3 Argus Mart Specific Attribute-Value set

Attribute Value

Argus Insight Application ~ Enables you to configure the data source for Argus Insight. You
Data Source may run your queries for Argus Insight or Argus Mart
depending on the value configured in this switch.

Argus Mart — Enable queries on Argus Mart data source only.

Insight Mart — Enable queries on Argus Insight data source
only.

Both (Insight Mart and Argus Mart) — You may choose between
Insight Mart and Argus Mart data sources for creating and
executing your queries. All the queries and case series created
on these data sources can be identified in the application.

ARGUSMARTDBNAME Specify the database instance name for the Argus Mart data
mart. This information enables to connect Argus Insight with
Argus Mart database.
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Table 5-3 (Cont.) Argus Mart Specific Attribute-Value set

Attribute Value
ARGUS MART USER Specify the schema user created for Argus Insight in Argus Mart
NAME database. This user may perform all the background functions

from Argus Insight application to Argus Mart database
including querying and reporting.

ARGUS MART USER Specify the password of the schema user created for Argus
PASSWORD Insight in Argus Mart database that is, the password of user
configured in ARGUS MART USER NAME.

ENABLE_AI_PROCESSING Note: Use Argus Safety Console to enable this profile switch.

This profile switch must be set to Yes to link Argus Insight
database to Argus Mart database.

Yes — Enable Argus Insight Processing for Argus Mart.
No — Disable Argus Insight Processing for Argus Mart.

Note: These profile switches are optional and should be configured
only if you want to run Advanced Conditions on Argus Mart
database.

Argus Mart database TNS should be added in the Argus Insight Web
Server TNS and Argus Insight Database Server TNS.

Argus Insight Database Server TNS should be added in the Argus
Mart Database TNS.

To set these attributes:

1. On the Administration Tools screen, click the List Maintenance tab.

2. From the List Maintenance Items group, select Profile Switches.

3. From the Attributes group, select a profile switch, and click Modify.
The Modify Attributes dialog box appears.

Note: See Table 5-3, " Argus Mart Specific Attribute-Value set".

4. In the Value field, enter a value, and click OK.
The profile switch is set and you return to List Maintenance tab.

5. Log on to Argus Safety Console in separate window, and set ENABLE_AI_
PROCESSING profile switch to Yes.

5.2.5 Setting the Attributes Specific ONLY to BIP

If you are using BIP as your Business Intelligence tool with Argus Insight, you need to
set the following BIP-specific attributes:

= BIP WEB URL

= KEEP REPORT DATA

To define the attributes required for BIP:

1. On the Administration Tools page, click the List Maintenance tab.
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From the List Maintenance Items group, select Profile Switches.
From the Attributes group, select BIP WEB URL.
a. Click Modify.

The Modify Attribute dialog box appears.

b. In the Value field, enter the name of the BIP Web URL to open the BIP home
page.
This URL can be the BI Publisher URL for standalone BI Publisher server or
the Load Balancer URL configured for multiple BI Publisher servers. If BI

Publisher is configured for SSL, you must use https with the URL. For
example:

https:/ /<server name>:<Port Number>/xmlpserver
c. Click OK to save the changes and return to the List Maintenance tab.
From the Attributes group, select KEEP REPORT DATA.

This attribute is used to determine if the report log tables needs to be populated or
not.

a. Click Modify.
The Modify Attribute dialog box appears.
b. In the Value field, enter Yes or No.

The value Yes denotes that the Report Log tables should be populated. The
value No denotes that the Report Log tables should not be populated

c. Click OK to save the changes and return to the List Maintenance tab.

5.2.6 Setting the Attributes Specific ONLY to OBIEE

If you are using OBIEE with Argus Insight, you need to set the OBIEE specific
attributes:

BI ANSWERS WEB URL

To define the attributes required for OBIEE:

1.
2.
3.

On the Administration Tools screen, click the List Maintenance tab.

From the List Maintenance Items group, select Profile Switches.

From the Attributes group, select B ANSWERS WEB URL, and click Modify.
The Modify Attributes dialog box appears.

In the Value field, enter the path for the Bl ANSWERS WEB URL.

For example, this path can be the OBIEE URL:

https://<server name>:<Port Number>/analytics

Click OK.

The profile switch is set and you return to List Maintenance tab.

5.2.7 Setting the Attributes Specific ONLY to BusinessObjects

If you are using BusinessObjects as your Business Intelligence tool with Argus Insight,
you need to set the attributes for BusinessObjects Servers for BusinessObjects
configurations only.
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To define the attributes required for the BusinessObjects Servers:

1. On the Administration Tools page, click the List Maintenance tab.

2. From the List Maintenance Items group, select Profile Switches.

3. Define the BusinessObjects Server Web URL that Argus Insight uses:
a. From the Attributes group, select BO WEB URL.

b. Click Modify.

The Modify Attribute dialog box appears.

c. In the Value field, enter either the IP address or the host name of the
BusinessObjects Server.

In addition, specify the cluster name if you are using the BusinessObjects

clustering feature.

Note: In the case of a single-server environment (that is, Argus
Insight and BusinessObjects are hosted on the same server), you must
enter the IP address to avoid problems when accessing the
BusinessObjects home page. These problems may be caused due to the
session interference of Argus Insight and BusinessObjects web

application.

d. Click OK to save the changes and return to the List Maintenance tab.

5.2.8 Setting the Attributes Specific ONLY to Cognos

If you are using Cognos as your Business Intelligence tool with Argus Insight, you
need to set the Cognos-specific attributes.

The following is the list of profile switch along with their value required to be set for

Cognos.

Table 5-4 Cognos Specific Attribute-Value set

Attribute Value

COGNOS Select the Enterprise Short Name from which all users are

AUTHENTICATION authenticated for Cognos login.

ENTERPRISE

COGNOS WEB URL Specify the name of the Cognos Web URL for opening the
Cognos home page.
This URL can be the Cognos URL for standalone Cognos server
or the Load Balancer URL configured for multiple Cognos
servers. If Cognos is configured for SSL, you must use https with
the URL.
Example: http://<server name>/Cognos102

POPULATE DLL SLL 0 — Do not populate the RPT_CASE_EVENT_PRODUCT table,

REPORTS TABLE DATA which is required for DLL and SLL reports

1 — Populate the RPT_CASE_EVENT_PRODUCT table, which
is required for DLL and SLL reports

Note: This attribute is obsolete in case of a fresh installation of
Argus Insight 8.1.1.

This attribute should be configured for the Detail Line Listing
Report and the Simple Line Listing Report.
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Table 5-4 (Cont.) Cognos Specific Attribute-Value set

Attribute Value
COGNOS SINGLE SIGN 1 — Cognos single sign on enabled
ON ENABLED

0 — Cognos single sign on disabled

Note: You must configure the COGNOS AUTHENTICATION
ENTERPRISE profile switch for Cognos integration. The default value
of this switch is Null.

To define the attributes required for Cognos:

1. On the Administration Tools screen, click the List Maintenance tab.

2. From the List Maintenance Items group, select Profile Switches.

3. From the Attributes group, select a profile switch, and click Modify.
The Modify Attributes dialog box appears.

Note: See Table 5-4, " Cognos Specific Attribute-Value set".

4. In the Value field, enter a value, and click OK.

The profile switch is set and you return to List Maintenance tab.

5.3 Configuring Duration Value Bands

In Argus Insight, you can map the following time values (entered in Argus Safety) to
specific ranges called Duration Value Bands:

s Time to Onset from First Dose
s Time to Onset from Last Dose

You set the value of these fields in Argus Safety by navigating to Product tab, Drug
Duration of Administration, and Events Tab.

By mapping the time values to Duration Value Bands in Argus Insight, you can specify
query criteria based on ranges instead of specific values for the Time to Onset fields
listed above.

Using the Duration Value Bands item on the List Maintenance tab, you can configure
duration value bands in hours, days, weeks, months, and years. For each band, you
can specify multiple ranges by entering minimum and maximum values for each
range item. Any value that falls within a configured range will map to that range.

Note: Duration Value Band configuration must be done before
running the Initial ETL.

If Duration Value Bands are modified after Initial ETL, you must
re-run the Initial ETL.

To modify a duration value band:

1. On the Argus Insight home page, click the Tools tab from the upper-right corner.
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The Administration Tools screen appears.
2. Click the List Maintenance tab.
3. From the List Maintenance Items group, select Duration Value Bands.

The Attributes group displays the valid bands (Hours, Days, Weeks, Months, and
Years). You can modify the values of these bands. You cannot, however, add more
bands or delete an existing band.

Note: When the Argus Insight Database Source profile switch is set
to Argus Mart, then in the List Maintenance section, only Profile
Switches and Case Series Modification Justification list maintenance
items are available.

For more information on this profile switch, see Section 5.2.4, "Setting
the Attributes Specific ONLY to Argus Mart".

4. Select the duration value band (Hours, Days, Weeks, Months, Years) you want to
change, and click Modify.

The Duration Value Bands Configuration dialog box appears with the
factory-configured ranges.

Note that:
»  The Label column represents the name of the range.

= The Lower Range (>=) and Higher Range (<) columns contain the minimum
and maximum values, respectively.

= The highest value band includes all values that are greater than the highest
range value specified.

5. Modify the values:

= To modify an existing range, edit the values in the Lower Range (>=) and
Higher Range (<) fields.

= Toadd a range, scroll to the current highest range and click in the blank
Higher Range (<) field.

Enter a value greater than the current highest range, and press Tab to add a
new row.

s To delete an existing range, click the Delete icon next to the row.
Note that you cannot delete the lowest band.

If you delete an intermediate range, the system automatically converts the
highest value of the deleted range to the lowest value in the next range.
However, the system does not change the range labels.

6. Click OK to save the changes.

5.4 Configuring Derivation Functions

You can create a new List Maintenance item and derive specific cases to this item
based on case attributes. These attributes are supplied to the system as SQL.

For example:
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1. Create a new List Maintenance item called Report Type 1, and derive all the cases
with the Report Type attribute defined as Spontaneous, Literature, or
Compassionate Use.

The Report Type 1 appears as an option in the query tool interface corresponding
to the Report Type attribute.

2. From the Report Type, select Report Type 1, and execute the query.

Cases with the Report Type attribute specified as Spontaneous, Literature, or
Compassionate Use are returned.

You can specify more than one attribute.

For example, create a further specialized List Maintenance item called Report Type 1
US, and derive all the cases that have the Report Type attribute defined as
Spontaneous, Literature, or Compassionate Use, and the Country of Incidence
attribute defined as United States.

Note: There can be situations where two different List Maintenance
items you create contain similar attributes in the SQL criteria. In this
case, you can assign a priority level to individual List Maintenance
items. The priority level determines which List Maintenance item SQL
executes first.

5.4.1 Opening the Derivation Fields Dialog Box

To open the Derivation Fields dialog box and configure derivation functions:

1.  On Argus Insight home page, click the Tools tab from the upper-right corner.
The Administration Tools screen appears.

2. Click the List Maintenance tab.

3. From the List Maintenance Items group, select Derivation Functions.

4. From the Attributes group, select All Derivations, and click Modify.

The Derivation Fields dialog box appears.

&1 Derivation Fields -- Webpage Dialog

Argus Field LM Table Suppress | Value Priority saL
\ [ AnaLYsE | CJBtaetd Information  »
== [ EVENTS L4 [ Case Aszeszment 4 @ Casze Qutcome
[C GENERAL r {I:'}_@Cﬂes Seripus
[PATENT L @ Listedness Determination
[Z3 PRODUCTS ’

QK Cancel

5.4.2 Icons in the Derivation Fields Dialog Box

Table 5-5 describes the icons in the Derivation Fields dialog box that you can use to
add, delete, and reorder derivation field elements (rows).
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Table 5-5

Icons in the Derivation Fields Dialog Box

2]
5
=

To...

L3
LU

Add a derivation field element (row) above the currently selected row

L
I

Add a derivation field element (row) below the currently selected row

Delete the currently selected derivation field element (row)

Move the selected row up

C B =

Move the selected row down

5.4.3 Field Mapping Derivation Rules

Table 5-6 lists the available field mapping derivation rules for Argus Insight.

Table 5-6 Field Mapping Derivation Rules
Function Category Function Sub-category Argus Insight Field
ANALYSIS BfArM Information Causality
ANALYSIS Case Assessment Case Outcome

Case Serious

Listedness Determination
EVENTS Event Information Lack of Efficacy
GENERAL General Information Report Type

Derived Pregnancy
PATIENT Patient Information Age Group

Gender

Patient weight BMI desc
PRODUCTS Product Drug Derived Drug Abuse

Derived Drug Interaction
Derived Overdose
Last daily dose

Note: Causality, Report Type, Age Group, and Last daily dose are
comma-separated derivation rules.

5.4.4 Fields and Check Boxes in the Derivation Fields Dialog Box

This section describes the fields and check boxes in the Derivation Fields dialog box.

5.4.4.1 LM Table
The LM Table field is the table name of the selected Argus field (that is, automatically

populated).
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5.4.4.2 Suppress

The Suppress check box is available for fields associated with the list maintenance
data. When suppress is enabled for a field, the corresponding list maintenance values
that are not present in any case are deleted and thus not available for querying.

Note: The Suppress check box is applicable only if the condition
specified in the SQL text box covers all the cases having the selected
List Maintenance field.

5.4.4.3 Value

The Value field captures the value for the new derivation field. For the following rules,
you must enter the new value for the rule as a comma-separated value:

»  Causality

s Report Type

s Age Group

= Last Daily Dose

Note: Make sure to enter the values for these rules as defined in the
following sections. Unexpected results and/or ETL errors may result
if the values are not entered as specified.

Causality Rule
Parameters: VALUE, REPORTABILITY

where:
VALUE = New value for the rule
REPORTABILITY = Lower value of the group
Example: NewCausality,1

Report Type Rule
Parameters: VALUE, INC_LIT, INC_TRIAL, ABRV

where:
VALUE = New value for the rule
INC_LIT =1 if Literature Report Type else 0
INC_TRIAL =1 if Clinical Trial Report Type else 0
ABRV = A 3-letter abbreviation for the Report Type
Example: NewReportType,0,1,NRT

Age Group Rule
Parameters: VALUE, GROUP_LOW, GROUP_HIGH

where:
VALUE = New value for the rule
GROUP_LOW = Lowest value of the age group
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GROUP_HIGH = Highest value of the age group
Example: NewAgeGroup,25,50
If you do not want to specify the High Value, then the comma is mandatory in the end.

Example: Unknown,70,

Last Daily Dose Rule
Parameters: VALUE, DAILY_DOSE_SORTING_ORDER

where:
VALUE = New value for the rule

DAILY_DOSE_SORTING_ORDER =1 or 2 or 3 and so on to define the sorting
order if there is more than 1 rule for the Last Daily Dose field

Examples: 1->0tol,1, 2->2to3,2 3->5t08,3

5.4.4.4 Priority

The Priority field captures the priority for a list of derivation rules applied to a single
List Maintenance field. The value should be from 1 to 255.

Note: The priority for derivation rules applicable to a single List
Maintenance field should be unique.

5.4.45 SQL

The SQL field specifies the SQL statement to capture the cases for which the derivation
rule is applicable.

Note: The SQL statement must follow the correct syntax.

The system does not validate the length of the new values against the
database. Make sure that new values being inserted into the Insight
data mart do not exceed the limit defined in the database.

Guidelines for correct syntax:

= The SQL query configured against a rule should not contain the table name. It
should contain only the primary key column name(s) of the field in the SELECT
clause. For example:

Correct: SELECT CASE_ID FROM RPT_CASE WHERE...
Incorrect: SELECT RPT_CASE.CASE_ID FROM RPT_CASE WHERE...

= Make sure that there is only one space after the SELECT clause in the SQL query.
For example:

Correct: SELECT CASE_ID, SEQ_NUM FROM RPT_PRODUCT WHERE...
Incorrect: SELECT CASE_ID, SEQ_NUM FROM RPT_PRODUCT WHERE...

= Make sure that no Oracle keyword (such as DISTINCT) is used after the SELECT
clause in the SQL query. For example:

Correct: SELECT CASE_ID, SEQ_NUM FROM RPT_PRODUCT WHERE...
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Incorrect: SELECT DISTINCT CASE_ID, SEQ_NUM FROM RPT_PRODUCT
WHERE...

5.5 Configuring the Argus Insight Windows Service

To configure the Argus Insight Windows service:

1. Log in to the Argus Insight Web Server.

2. Click Start, and select Run.

3. In the text box, enter services.msc, and click OK.
The Services screen appears.

4. Right-click Argus Insight Service, and select Properties.
The Argus Insight Service Properties dialog box appears.

5. Set the value of the Startup type field to Automatic.

6. Click Start to start the Argus Insight Service.

7. Click OK to apply the changes.

Note: To change the interval of different service tasks, modify the
entries in the Service.config file located in the Bin folder of Argus
Insight. All the timestamps in the Service.config file are specified in
seconds.

IMPORTANT! Ensure that the user who runs this service has administrator privileges.

5.6 Configuring the lIS File Download Limit
To configure the IIS file download limit for Windows 2012:
1. Go to the Internet Information Services (IIS) Manager.
2. Double-click ASP in the right pane.
The ASP dialog box appears.

3. Expand Limit Properties and change the Response Buffering Limit from 4 MB
(default) to a large value such as 200000000 (200 MB).

4. From Actions in the left pane, click Apply.
5. Restart the IIS service.

a. Click Start, and select Run.

b. In the text box, enter iisreset -start.

c. Click OK.

5.6.1 Configuring the Maximum Requesting Entity Body Limit

Defining a value for the Maximum Requesting Entity Body Limit setting is optional.

You may need to set this value only if you use custom SQL scripts in advanced
conditions and only if the scripts have more than 70,000 characters.
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If you receive AJAX errors when saving your custom SQL scripts that have more than
70,000 characters, you can increase the value of the Maximum Requesting Entity
Body Limit setting in the IIS. Increasing the setting ensures that the ASP can post that
much data onto the server.

To change the value of the Maximum Requesting Entity Body Limit setting:

1.
2.

Go to the Internet Information Services (IIS) Manager.
Double-click ASP in the right pane.
The ASP dialog box appears.

Expand Limit Properties and change the Maximum Requesting Entity Body
Limit from 200000 Bytes (default) to a large value (preferably 5000000 Bytes).

From Actions in the left pane, click Apply.
Restart the IIS service.

a. Click Start, and select Run.

b. In the text box, enter iisreset -start.

c. Click OK.

5.7 Using Export and Import to Copy Configuration Data

Before configuring export and import functions, be aware of the following:

Before importing or exporting to or from a network drive, verify that you have
mapped the network drive. This tool does not support direct access to network
drives.

Before copying Argus Data, incremental ETL should be completed on Source
Insight Database from Source Argus.

It is assumed that the configuration of the instance of Argus used to run Initial and
Incremental ETL on the source Argus Insight data mart will also be copied and
applied on the new Argus Instance which will be associated with the new Argus
Insight data mart.

Data must be imported after loading Factory Data and before running Initial ETL
on destination environment.

In a multi-tenant environment, you must make sure that all the enterprises which
are part of the source Argus Insight database, have been created in the Target
Argus Insight database.

5.7.1 Exporting Data

1.
2

Start the Argus Insight Schema Creation Tool.

Click Export Data.

The Export Utility command prompt screen appears.

Enter the following details when prompted, and press Enter:
a. TNSNAMES entry of the Argus Insight Database

b. DBA User

c. DBA User Password

d. Mart Schema Owner Name

Configuring the Argus Insight Application 5-15



Using Export and Import to Copy Configuration Data

10.

e. Mart Schema Owner Password
f. DB Directory path for export dump files (database server file path)
Enter a directory path specific to your database environment.

The Export Dump file and Export log file will be placed here as
INSIGHT.DMP and Export_log.log respectively.

g. Directory Name (in capital letters) to be created in the database

A database directory is created with this name at the path mentioned in the
previous step.

h. Directory including full path for log/script files (Local Machine)

Enter a directory path specific to the machine where the Copy Configuration
utility is being run.

The user specified log file and files named application_type_check.sql,
insight_export_tables.par, and truncate_delete_tables.sql will be generated
here.

i. Name of the log file

Verify that the script is successfully connected as <DBA User Name>@<Argus
Insight Database Name>, and press Enter.

The command prompt screen with the Encryption wallet verification status
appears.

Verify the details mentioned on the command prompt screen, and press Enter if:
= TDE is setup and Wallet is open

= TDE is not setup and Wallet is not open

The command prompt screen with Directory creation status appears.

Press Enter if the Directory Path is valid.

Verify that the script is successfully connected as <APR_MART User
Name>@<Argus Insight Database Name>, and press Enter.

The command prompt screen with list of parameters appears.

Press Enter to resume if the parameters are valid.

Verify the details mentioned on the command prompt screen, and press Enter.
Enter the password for the APR_MART user, and press Enter.

A data export completed screen appears with a list of all the output files.
Verity the location of files, and press Enter to Exit.

Make sure to review the all the log files for information about the export and
export errors.

5.7.2 Importing Data

1.
2.

Start the Argus Insight Schema Creation Tool.
Click Import Data.
The Import Utility command prompt screen appears.

Press Enter if all prerequisites are satisfied.
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10.

11.

Enter the following details when prompted, and press Enter:

a. TNSNAMES entry of the Argus Insight Database
b. DBA User

c. DBA User Password

d. Mart Schema Owner Name

e. Mart Schema Owner Password
f. DB Directory path for import dump files (database server file path)
Enter a directory path specific to your database environment.

INSIGHT.DMP created in the export process is copied here. Beside, Import_
log.log is also created here.

g. Directory Name (in capital letters) to be created in the database

A database directory is created with this name at the path mentioned in the
previous step.

h. Directory including full path for log/script files (Local Machine)

Enter a directory path specific to the machine where the Copy Configuration
utility is being run.

The user specified log files are generated here.

Besides, make sure that the files named application_type_check.sql, insight_
export_tables.par, and truncate_delete_tables.sql that were generated during
export process are also copied here.

i. Name of the log file

Verify that the script is successfully connected as <DBA User Name>@<Argus
Insight Database Name>, and press Enter.

The command prompt screen with the Encryption Wallet Verification status
appears.

Verify the details mentioned on the command prompt screen, and press Enter if:
s TDE is setup and Wallet is open

= TDE is not setup and Wallet is not open

The command prompt screen with Directory Creation status appears.

Press Enter if the Directory Path is valid.

Verify that the script is successfully connected as <APR_MART User
Name>@<Argus Insight Database Name>, and press Enter.

The command prompt screen with list of parameters appears.

Press Enter to resume if the parameters are valid.

Verify the details mentioned on the command prompt screen, and press Enter.
Enter the password for the APR_MART user, and press Enter.

A data import completed screen appears.

Press Enter to Exit.

Make sure to review the all the log files for information about the import and
import errors.
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5.8 Using Argus Safety to Configure Enterprises for Argus Insight (for
Mutli-tenant installation only)
You must be a valid LDAP user and have access to the Argus Safety global home page.

See the Global Enterprise Management section of the Argus Safety Installation Guide for
detailed steps on logging and accessing Argus Safety global home page.

To create an enterprise in Argus Insight:
1. Log in to the Global Enterprise Management portlet.
2. From the Enterprises folder, select an enterprise from the left pane.
The Enterprises folder includes enterprises as per you access privileges.
3. To create the selected enterprise in Argus Insight, click Copy Enterprise to Insight.
Note that the Copy Enterprise to Insight button is:
= disabled if the selected enterprise already exists in Argus Insight.
= enabled if you have Copy Configuration role in any of the listed enterprises.

4. In the Copy Enterprise Configuration From field, select the source enterprise
from which the information will be copied.

Note that the drop-down list includes only those enterprises that meet the
following conditions:

= The enterprise has already been created in Argus Insight.
= You have been assigned Copy Configuration privileges for the enterprise.
5. Click Setup.

The process to copy the configuration begins and a status information appears
throughout the process.

6. Click Finish.

5.9 Securing Sensitive Configuration and Operational Data

For security reasons, you should configure permission settings for certain files and
folders on the Argus Insight Web Server. The permission settings make sure that only
the IIS user can access these files. Local system login accounts that are not part of the
Administrators group cannot make changes to the files.

Windows Directory File

For the user under which IIS is running, the ai.ini file requires a permission of Full
Control.

Shared Folders

For the user under which IIS is running, the following folders require a permission of
Full Control:

s CacheTemp

= ScheduledReports
s PDFReports

= ASP

n Bin
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Extracting, Transforming, and Loading Data

This chapter describes the steps required to run and work with the initial extract,
transform, and load (ETL) process.

6.1 Prerequisites, Cautions, and Warnings

Before running the Initial ETL, make sure:

The Auto extend is set to ON for all the data files in the database that are related to
staging and Insight Mart.

The POPULATE CASE/CONFIGURATION DATA profile switch is configured to
the desired value.

In addition, note that:

Since the initial ETL requires a huge amount of temporary space, set the
temporary space to 100 GB to prevent data errors. After completing the Initial ETL,
reduce the temporary space to 30 GB.

After the Initial ETL completes, the balancing log may show differences between
the Argus (Stage) and Insight Mart table counts. This is because of the derivation
rules applied to the Insight data mart.

The system may display the following message:
Warning !!! - Could not locate MedDRA-J User in the Argus Database.
Ignore this warning for all MedDRA tables.

Do not run incremental ETL for more than 50,000 cases. Run the Initial ETL again
if the number of cases exceeds 50,000.

The Argus Insight ETL will not populate the Argus Mart database.

Refer to the Oracle Argus Mart Installation and Administration Guide for more
information on the Argus Mart ETL.

6.2 Running the Initial ETL

1.

2.
3.

Log in to the Argus Insight Web Server as a user with administrator privileges.
Click Start.

Navigate to Programs > Oracle > Argus Insight, and then select Schema Creation
Tool.

Click Initial ETL.
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The Oracle Database Connect dialog box appears.

To connect to the Oracle Database:

a. In the Password field, enter the password for the APR_MART user.
b. Inthe Database field, enter the name of your Argus Insight database.
c. Click OK.

The Initial ETL Status dialog box opens.

Click Start ETL.

The initial process of extracting, transforming, and loading data begins. A message
confirming that you have completed the required configuration steps appears.

Click Yes if these items have already been configured.

The Initial ETL Status dialog box appears stating the ETL start time, the progress
bar, and the current process in execution.

While the ETL is in progress, you can:

= To close the dialog box, and exit from the Schema Creation Tool, click Close.
Closing the dialog box does not affect the execution of the ETL process.

= To halt the ETL process, click Stop ETL.

For more information about this option, see Section 6.2.3, "Stopping the
Execution of ETL."

A status message appears when the initial ETL process is completed.

6.2.1 Generating the Balance Logs

When the system successfully completes the Initial ETL process, you should generate
and check the logs.

To generate the balance logs:

1.

Wait until the dialog box that reports the initial ETL completed successfully
appears.

Click Balancing Logs.

A dialog box appears to confirm that you want to generate balancing logs for the
completed Initial ETL appears.

Click OK.
The command prompt screen appears.
Enter the password for the APR_MART user, and press Enter.

Verify that the script is successfully connected as <APR_MART User
Name>@<Argus Insight Database Name>, and press Enter.

The command prompt screen appears and the balancing logs are generated.

When the logs are generated, a dialog box with the location and name of the log
files appears.

Click OK to close the dialog box.
Open and verify the contents of each Balancing Report.

The Balancing Reports are located at:
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drive:\VSS SOURCE\ Argus Insight\Main Source\Database Source\DBInstaller
The log files are named as:

s etl_ini_atos_bal_Im_cfg_rep.log

= etl_ini_atos_bal rep.log

s etl_ini_stom_bal Im_cfg rep.log

= etl_ini_stom_bal_rep.log

6.2.2 Closing the Initial ETL Status Dialog Box

1.

Click Close.

A message to confirm that you want to close the Schema Creation Tool application
appears.

Click OK.

6.2.3 Stopping the Execution of ETL

You may choose to stop an ETL in progress.

To halt the execution of the initial ETL process:

1.

Click Stop ETL.

A message to confirm that you want to stop the ETL currently in progress appears.
Click OK.

The ETL process is stopped and returns to the Initial ETL Status dialog box.

At this point, you can select one of the following options:

» To continue extracting, transforming, and loading the data that was in
progress, click Continue.

»  To start the initial ETL from the beginning, click Restart ETL.

s  To exit from the Schema Creation Tool application, click Close.

6.3 Running the Initial ETL Again

To start the ETL process from the beginning;:

1.

Click Run ETL.

A message to confirm whether you want to start the initial ETL from the
beginning appears.

Click OK.
The Oracle Database Connect dialog box appears.
Enter the password for the APR_MART user, and then click OK.

The initial ETL process starts from the beginning.

6.4 Processing a Failed ETL

The initial ETL may fail due to an error. If an error occurs, the system stops processing
the ETL and displays error message.
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You may choose any of the following options for the failed Initial ETL process:

To continue the failed Initial ETL process, click Continue.
To ignore the failed Initial ETL process, click Ignore.

For ETL Data Exclusion, click Modify Attributes, if PRE_REQ_CHECK_FLAG
switch is set to ABORT.

Note: These modifications must be done before running the Initial
ETL process.

6.4.1 Continuing the Failed Initial ETL Process
To continue the Initial ETL process from the failed ETL procedure:

1.

Double-click on the ETL error.
The Error Data dialog box appears with details of the error.
Review the error information, and then click OK.

Right-click on the ETL Error, and click Copy to copy the error data.

=) Initial ETL Status =

ETL Time
Start Time of Last ETL Run:

Start Time: Gr2652014 3:56:30 P

ETL Process

Current Process: Error while executing initial etl procedure - p_compile_objects_with_log

ETL Completed/ an
Total Enterprises:

ETL Error -

Log Id Process Mame Process Description | lzsue Details
4045 €_oDjec 0g Error while executing.. ORA-Z0010: C Hkia

Continue | Ignare Restart ETL Close

4. Click Continue to continue the failed ETL process.

A message to confirm that you want to start the initial ETL from the stopped
process appears.

Click OK.

The ETL process continues (if no errors are found).

6.4.2 Ignoring the Failed Initial ETL Process

To ignore a failed ETL process and continue with the next process in the ETL:

1.

Click Ignore.
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A message to confirm that you want to skip the failed process and continue
executing the Initial ETL with the next process appears.

Click OK.

The Initial ETL begins from the next process and continues with the ETL process
(if no errors are found).

6.4.3 Modifying the Attributes of ETL Data Exclusion

You must modify these attributes before ETL execution.

1.
2.

Log in to the Argus Insight application as a user with administrator privileges.
On Argus Insight home page, from the upper-right corner, click the Tools tab.
The Administration Tools screen appears.

Click the List Maintenance tab.

Select Profile Switches from the List Maintenance Items group.

The Attributes group is updated with the profile switches that you can modify.
Select ETL Data Exclusion, and click Modify.

The Modify Attribute dialog box appears.

Click the Value field, and enter one of the following values:

s If you want the ETL process to skip cases with erroneous data and continue
processing all other cases, enter IGNORE.

= If you want the ETL process to abort when it encounters cases with erroneous
data, enter ABORT.

Click OK to save the changes and return to the List Maintenance tab.

6.5 Restarting the Initial ETL Process

To restart the Initial ETL process starting from after the confirmation message and
APR_MART password input:

1.

Click Restart ETL.

A message to confirm that you want to start the initial ETL from the beginning
appears.

Click OK.
The Oracle Database Connect dialog box appears.

Enter the APR_MART user password, the Argus Insight Database name, and click
OK.

Click Start ETL to start the initial process of extracting, transforming, and loading
data.

A message to confirm that you have completed the required configuration steps
appears. See Section 5.2 > Step 6.

Click Yes if these items have already been configured.

The Initial ETL Status dialog appears with the ETL start time, the progress bar, and
the current process in execution.

When the system finishes the ETL process, click Close.
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Configuring the BIP Environment

When you have installed the BI Publisher (BIP), you need to configure certain settings
to be able to view the available reports in BIP. This chapter introduces you with the
steps to make those configuration changes using BIP.

7.1 Creating PRMART JDBC Connection

If you are installing BIP on a Windows machine, the TNS entry of Argus Insight must
be added in TNSNAMES.ora file of the BIP Web Server.

If BIP is installed on a Linux machine, no modifications to the TNSNAMES.ora file are
required.

When you have uploaded the Argus Insight.xdrz file to BIP, you also need to create a
connection between the BIP and the database.

To connect the BIP and the database:

1.

Log on to BIP using the administrator credentials.

The BIP home page appears.

From top-menu, click Administration.

In the Data Sources section, click JDBC Connection.

The Data Sources screen appears.

Click Add Data Source.

In the Add Data Source section:

a. In the Data Source Name field, enter PRMART.

b. From the Driver Type drop-down list, select the database.

The Database Driver Class field is auto-populated based on the selected
Driver Type.

c. Inthe Connection String field, enter the connection string.
You must enter all the details in lower case in this field.

d. Inthe Username field, enter the username (Argus Insight application DB user,
for example, apr_app) to connect to the database.

e. In the Password field, enter the password for the user.
f. Click Test Connection.

If successful, a confirmation message appears.
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Click Apply.

The PRMART Data Source in the list of already existing data source names
appears.

A connection between BIP and the database is successfully created.

7.2 Managing Users and Roles: Bl Publisher Standalone Installation with
Bl Publisher Security

When you have uploaded the Argus Insight.xdrz file to BIP and created the JDBC
connection, you can start creating the users for the BI Publisher Security Model.

This section introduces you to the steps that you need to execute to create users, assign
the roles and permissions to those users, and configure server settings for the BI
Publisher Security Model.

7.2.1 Creating Users and Assigning Roles to Users

To create users and assign the required roles to the users in the BIP Security Model,
execute the following steps:

1.

Log on to BIP using the administrator credentials.

The BIP home page appears.

From top-menu, click Administration.

Refer to Section 6.2 > Step 2.

In the Security Center section, click Users.

The Users screen appears.

Click Create User.

The Create User screen appears.

In the Username field, enter the name of the user.

In the Password field, enter the password.

Click Apply.

The name of the user appears in the list of existing users.
When you have created the user, you need to assign the required roles to the user.

Click the Assign Roles icon corresponding to the user that you have created.
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The Assign Roles screen appears.

The BIP system roles such as BI Publisher Administrator, BI Publisher Excel
Analyzer, BI Publisher Online Analyzer, BI Publisher Developer, BI Publisher
Scheduler, and BI Publisher Template Designer are available by default along with
the custom roles (if any) that have been created by you.

See Section 7.2.2, "Creating Roles, Adding Data Sources, and Assigning Roles" for
the steps to create custom roles.

For more information on system roles, refer to Understanding BI Publisher's Users,
Roles, and Permissions in Administrator's Guide for Oracle Business Intelligence
Publisher.

From the Available Roles section, select the role that you want to assign to the user,
and click Move(>) to move the selected role to the Assigned Roles section.

Click Apply.
The selected roles are assigned to the user.

For the list of users that you need to configure using BIP, refer to Section 7.4,
"Configuring BIP Users and Roles: Oracle Fusion Middleware Security Model".

7.2.2 Creating Roles, Adding Data Sources, and Assigning Roles

In

addition to creating users and assigning them the required roles, you also need to

create certain roles, add data sources, and assign them the required roles.

1.

Log on to BIP using the administrator credentials.

The BIP home page appears.

From the top-menu, click Administration.

Refer to Section 6.2 > Step 2.

In the Security Center section, click Roles and Permissions.
The Roles and Permissions screen appears.

Click Create Role.

The Create Role screen appears.

Enter the Name and Description of the role, and click Apply.
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The new role is created and appears in the list of existing roles in the Roles and
Permissions screen.

6. Click Add Data Sources icon, corresponding to the role which you have just
created.

ORACLE" BI Publisher Enterprise @ | Administration | Help | Sgnout O

Administration Home | Catalog | B New~ | B® Open~ |SignedinAs puneets >

Administration > Roles and Permissions

Security Center

Security Configuration | Users | Roles and Permissions | Digital Signature

Add Data Sources Add Roles Delate
ann @
snutkRole E' aar m

The Add Data Sources screen appears.

7. Form Available Data Sources section, select PRMART, and click Move(>) to move
it to the Allowed Data Sources section.

8. Click Apply to save the changes.
The Roles and Permissions screen appears.

See Section 7.1, "Creating PRMART JDBC Connection" for the steps to create the
JDBC connection.

9. Click the Add Roles icon, corresponding to the role which you have just created to
add the required roles.

The Add Roles screen appears.

10. From the Available Roles section, select the roles that you want to include, and
click Move(>) to move the selected roles to the Included Roles section.

11. Click Apply to save the changes.

For more information, refer to the Configuring Users, Roles, and Data Access
section in the Oracle BIP Administrator's Guide.

For the list of roles that you need to configure using BIP, refer to Section 7.4,
"Configuring BIP Users and Roles: Oracle Fusion Middleware Security Model".

7.3 Managing Users and Roles: Bl Publisher Standalone Installation with
OFM Security

This section introduces you with the steps that you need to execute to create users,
assign the roles and permissions to those users, and configure server settings for the
Oracle Fusion Middleware (OFM) Security Model.

7.3.1 Creating Users and Assigning Roles to Users

Creating users for LDAP or SSO users is done using the LDAP servers which is
beyond the scope of this manual.

For the list of users that need to be configured, refer to the Section 7.4, "Configuring
BIP Users and Roles: Oracle Fusion Middleware Security Model".
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7.3.2 Bl Publisher Standalone Installation in OFM Security

This section provides the steps to create roles, policies, users, and groups in OFM
(Oracle Fusion Middleware) Security for BIP Standalone Installation.

7.3.2.1 Creating Users and Groups
1. Open the WebLogic Administration Console.

2. Navigate to Security Realms > myrealm > Users and Groups > Groups tab.

3. From the Groups section, and click New.
The Create a New Group dialog box appears.

4. Create the following groups by entering the Name and Description, and click OK.
s ATAdminGroup
s AlAuthorGroup

s AlConsumerGroup

To create users in the Fusion Middleware Control:
1. Open the WebLogic Administration Console.

2. Navigate to Security Realms > myrealm > Users and Groups > Users.
3. From the Users section, and click New.

The Create a New User dialog box appears.
4. Enter the parameters, and click OK.

5. To assign a group to the user, from the Groups tab, select a Group, and click Save.

Note: For more details, refer to Section 2.5.2 Managing Users and
Groups Using the Default Authentication Provider in
https://docs.oracle.com/middleware/1221/bip/BIPAD.pdf.

7.3.2.2 Creating Roles and Policies

To create new application roles:
1. Login to Fusion Middleware Control Enterprise Manager.

2. Go to WebLogic Domain > Security > Application Roles.
The Application Roles dialog box appears.

3. From the Application Stripe drop-down list, select OBI, and click Search .
The default role available in clean slate installation appears.

4. Click Create.
The Create Application Role dialog box appears.

5. In the Role Name field, enter AIAdminRole.

6. From the Members section, click +Add.
The Add Principal dialog box appears.

7. From the Type drop-down list, select Group, and click Search.
A list of principals appears.
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10.

11.

12.
13.

From the list of Searched Principals, select AIAdminGroup, and click OK.

From the Members section, click +Add.

The Add Principal dialog box appears.

From the Type drop-down list, select Application Role, and click Search.

A list of principals appears.

From the list of Searched Principals, select BIServiceAdministrator , and click OK.
The Membership for AIAdminRole appears.

To add AIAuthorRole, repeat from Step 4 to Step 11.

To add AIConsumerRole, repeat from Step 4 to Step 11.

Note: For more details, refer Section 2.8.3.1 Creating Application Roles
Using Fusion Middleware Control in
https://docs.oracle.com/middleware/1221/bip/BIPAD.pdf

To create new application policy:

1.
2.

10.

11.
12.

13.

Login to Fusion Middleware Control Enterprise Manager.

Go to WebLogic Domain > Security > Application Policies.

The Application Policies screen appears.

To create a new application policy, click Create.

The Create Application Grant dialog box appears.

From the Grantee section, click +Add.

The Add Principal dialog box appears.

From the Type drop-down list, select Application Role, and click Search * .
From the list of Searched Principals, select AIAdminRole, and click OK.
From the Permissions section, click +Add.

The Add Permission dialog box appears.

Select the Resource Types radio button.

From the Resource Type drop-down list, select oracle.bi.publisher.permission,
and click Search.

From the Search Results, select oracle.bi.publisher.permission (BIP Administer
Server), and click Continue.

The Add Permission dialog box appears.
For Permission Actions, select All (_all_), and click Select.
Add Resource Name as oracle.bi.user with Impersonate permission.

The new AI Admin policy has all the permissions.

Note: Make sure all the fields are either selected or entered manually.

Repeat from Step 4 to Step 12, to add the following;:
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Name Grantee Resource Permissions
AI Author ATAuthorRole BIP Develop Report
BIP Develop Data Model
AI Consumer AlConsumerRole BIP Access Excel Report Analyzer

BIP Access Online Report Analyzer
BIP Access Report Output
BIP Schedule Report

Note: For more details, refer to Section 2.8.3.2 Creating Application
Policies Using Fusion Middleware Control from
https://docs.oracle.com/middleware/1221/bip/BIPAD.pdf.

7.3.3 Creating Roles, Adding Data Sources, and Assigning Roles in WebLogic
Enterprise Manager

To create roles, add data sources, and assign roles in WebLogic Enterprise Manager,
execute the following procedure:

1. Log on to the Enterprise Manager.
The Enterprise Manager home page appears with a list of folders in the left pane.

2. In the left pane, expand the Business Intelligence folder, and click
coreapplication.

The Coreapplication screen appears in the right pane.

3. Inthe Application Policies and Roles section, click Configure and Manage
Application Roles.

The Application Roles screen appears.
4. From the Application Stripe drop-down list, select the required application stripe.

5. Select any existing role (for example, BIConsumer), and click Create Like.

ORACLE Enterprise Manager 119 Fusion Middlewars Control
SEFam - 2, Topology

B~ 1} coreapplication @ Logged in as weblogic

=1 B8 Farm_bifoundation_domain [&] Business Inteligence Instance »
[# [ application Deployments
[# [ wisbLogic Domain

Setupw Helpw Log Out

Page Refrashed Sep 29, 2012 4:37:53 PM EDT 0

- Application Roles o
(= [ Business Intelligence Application roles are the roles used by security aware applications that are specific ko the application. Thess roles are seeded by applications in singls
&l coreapplication g\ub‘a\ ?Jhcy store when the applications are registered. These are also application roles that are created in the context of end users accessing the
application.

[ [ Metadata Repositories
£ To manage users and groups in the WebLogic Domain, use the Oracle Weblodic Server Sscurity Providsr.,

=Policy Store Provider
Seope WebLogic Domain
Provider ¥ML
Location jsystem-jazn-data.xml
Elsearch

Enker search keyward For role name to query roles defined by this application, Use application strips b search if application Uses a stripe that is
: )

l application Stripe [ b v
Role Name [ Starts with )] @]
4 Create.., || (8 Createlike. | A Edt.. 3@ Delete...
Rale Name Display Name Descrigtion
EISystem BI System Role A
ElAdministrator BI Administrator Role
BTATTTr BTATtOrRTiE
BIConsumer BI Consumer Rale
= E-hep 2 Na Data model access
ALReparterGrp AL Report yiriter Graup Na Data model access
ALDataModelarp AL Data Madel Group Access ko DM and Reports - Authar rale.
ENTI ENTERPRISEL Oy users having Ent1 privilege can access .
ENT2 ENTERPRISEZ In EIP user having this role can access ENTZ..
ALAdministratorGrp AL Administrators Group Admin access
ArgusInsightGrp Argus Insight Group All enterprise specific roles should be memb...
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The Create Application Role screen appears.
6. In Role Name field, enter the name of the role.
7. Optionally, enter the Display Name and Description for the role.

8. Toadd any existing application role/group/user to the new role, click Add.

ORACLE Enterprise Manager 11g Fusion Middieware Control Setup v Help»  Log Out
Giramw | & Topology
- 1} coreapplication ® Logged in as weblogic
=1 B Farm_bifoundation_domain Business Intelligence Instance + Page Refrashed Sep 30, 2012 6:07:08 AM EDT L2
# 3 Application Deplayments
[# 2 WebLogic Domain Application Roles = Create Application Rale
= [ Business Inteligsnce Create Application Role Like : BIConsumer | OK | | Cancsl

[&] [coreapplication General
[ [ Metadata Repositories

=
* Role Mame | airoleuser

Display Mame | siroleuser

o

P

Members
An application role may nesd ko be mapped to users or groups defined in enterpriss LDAP server, or the rols can be mapped to other application roles.

o Add B2 Delete..,

4 Display Name Type
BIConsUmers Group
BlAuthor Application Role
authenticated-rols Authenticated Role

The Add Principal screen appears.

9. To display the list of all the roles, groups, and users that are created in LDAP
server, click the > icon next to the Display Name field.

10. Select the name of the role, group, or user that you want to add to the new role,
and click OK.

11. Repeat steps 8 to 10 to add more roles, users, and groups to the new role.
12. On Create Application Role screen, click OK to save the changes.

When you have created the role and added the required list of users, roles, and
groups to the new role, you must add the PRMART data source to the new role.

13. Log on to BIP using the administrator credentials.
The BIP home page appears.

14. From top-menu, click Administration.
Refer to Section 6.2 > Step 2.

15. In Security Center section, click Roles and Permissions.
The Roles and Permission screen appears.

You can view the name of the new role which you have just created in the list of
role names.

16. Click the Add Data Sources icon corresponding to the name of the new role.
The Add Data Sources screen appears.

17. From the Available Data Sources section, select PRMART, and click the Move (>)
icon to move the PRMART data source to the Allowed Data Sources section.

18. Click Apply to save the changes.

For more information, refer to the Oracle BIP Administrator's Guide > Creating
Application Roles Using Fusion Middleware Control section.

For the list of roles that need to be configured, refer to the Section 7.4,
"Configuring BIP Users and Roles: Oracle Fusion Middleware Security Model".
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7.3.4 Creating Application Policy

Once you have created the new role and assigned the required roles, users, and data
sources to the role, you also need to create the application policy for the new role.

Before creating a BI Publisher policy, you must have created an empty role in the
Enterprise Manager.

Note: The steps mentioned in this section are valid for creating
BIReportWriter application policy.

To create the application policy for the new role, execute the following steps:

1.

Log on to the Enterprise Manager.
The Enterprise Manager home page appears with a list of folders in the left pane.

In the left pane, expand the Business Intelligence folder, and click
coreapplication.

The Coreapplication screen appears in the right pane.

In the Application Policies and Roles section, click Configure and Manage
Application Policies.

The Application Policies screen appears.
From the Application Stripe drop-down list, select obi.
Select the BIAuthor policy, and click Create Like.

The Create Application Grant Like screen appears with the Grantee and
Permissions sections.

In the Grantee section, click Add.
This displays the Add Principal Screen.

To retrieve the list of all the available application roles, click the > icon next to the
Principal Name field.

From the Searched Principals section, select the name of the role (for example,
BIReportWriter), and click OK.

The Create Application Grant Like screen appears.

From the list of Permission Classes, select the developDataModel resource name,
and click Delete.

10. Click OK to apply the changes.

7.3.5 Uploading the Argus Insight.xdrz file to BIP

Note: You must be logged in to BIP with the BI Admin User
credentials to be able to upload the Argus Insight.xdrz file.

Copy the Argus Insight.xdrz file from the following location on the Argus Insight
Web Server to the local file system:

Drive:\<Argus Insight Installation Folder>\ Arguslnsight\BIP\Repository
Log on to BIP using the BI Admin User credentials.
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The BIP home page appears.

From the menu bar, click Catalog.

The Catalog screen with the Folders and Tasks sections appears.
From Folders section in the left pane, click Shared Folders.
From Tasks section in the left pane, click Upload.

The Upload dialog box appears.

Click Browse and navigate to the location where you have saved the Argus
Insight.xdrz file on the local file system.

Click Upload.
After successful upload, an Argus Insight folder is created in Shared Folders.

Expand the Argus Insight folder to verify that the Generic Line Listing Data
Model exists in the Data Models sub-folder and the Generic Line Listing Report
in LE and RTF formats exists in the Reports sub-folder.

7.4 Configuring BIP Users and Roles: Oracle Fusion Middleware Security

Model

This section lists the names of the <Admin Users> and roles that you need to configure
using the steps given in Section 7.2, "Managing Users and Roles: BI Publisher
Standalone Installation with BI Publisher Security" and Section 7.3, "Managing Users
and Roles: BI Publisher Standalone Installation with OFM Security".

Table 7-1 Configuring BIP Users: Oracle Fusion Middleware Security Model

User Description

BI Admin User An Admin user refers to the user who has BI Publisher administrative

rights. This user should belong to the BIAdministration functional
role.

Data Modeler Users An Argus Insight Data Model user refers to the user who should have

access to both Data Models and Reports in the Argus Insight folder.
This user should belong to AIDataModeler custom role.

There are Enterprise specific Modeler users, who have access to Data
Models and Reports in Enterprise specific folders and Argus Insight
folder. These users should have Enterprise specific Modeler roles
assigned to them. This user should belong to Enterprise specific
Modeler roles.

Users An Argus Insight Role (AIRole) user refers to the user who should

have access to Reports only, and should have Read-only access to the
Data Model which is required to create the reports. This user should
belong to AIRole.

There can be users who have access to reports of specific Enterprises.
These users can Read /Write reports in Enterprise specific Report
folder and Argus Insight Report folder. However, these users have
Read-only access to the Data Models in the Enterprise specific Data
Model and Argus Insight Data Model folder. This user should belong
to Enterprise specific Report roles.

Global Admin Users ~ An Al Admin Role user should have full access to the Argus Insight

folder (Read/Write/Delete).

An Enterprise specific Admin user should have full access to the
Enterprise specific folders (Read /Write/Delete) and Argus Insight
folder (Read /Write/Delete).
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7.4.1 Configuring BIP Roles

The following table illustrates the roles that you need to configure using BIP:

Table 7-2 Configuring BIP Roles

Role Users/Roles to be added

BIAdministration Super user who has full access to any folder and BIP

(Functional Role) Administration access

AlRole All Argus Insight role users, AIDataModelerRole, and All
Enterprise Report Roles (for specific enterprises)

AlDataModelerRole All Al Data Modeler Users, All Enterprise Modeler Roles, and
ATAdminRole

Enterprise Report Role Users that belong to a specific Enterprise with Reports access

Enterprise Modeler Role
Enterprise Admin Role

AIAdminRole

BIAdministrator (Functional
Role)

BIAuthor (Functional Role)

BIReportWriter (create this
role using the steps given in
section 8.4.3 and create an
Application Policy for this
role using the steps given in
section 8.4.4)

and Enterprise Modeler Role

Users that belong to a particular Enterprise with both Data
Models and Reports access

Enterprise specific Admin users. These users should have full
access to the Enterprise specific folders.

Any User with this role should have full access to the Argus
Insight Folder. The Enterprise Admin Role should be added to
this role.

BI Admin User

AlDataModelerRole
AlIRole

7.4.2 Folder Level Permissions

Viewing folder level permissions for Bl Publisher Standalone Installation:

You cannot see the permissions of shared folder for BIP Stand-Alone installation.
Besides, the Argus Insight folder permissions appears.

Permissions

Location fArgus Insight

% Apply permissions to items within this folder

+

Role Name

&1 AladminRaole
34-" AlCansumerfole

.".E AlduthorRola

9 X
M)
Run View
. Schedule
Read Write Delete  Report Ramn“ Report
Online Output
+ o ~ e ~ J
1 ] v’ v o
| o ) o ) < W
OK Cancel

To assign folder level permissions for BIP Integrated Installation (OBIEE+BIP):
1. Login to OBIEE Analytics with the WebLogic user credentials.
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2. Go to Catalog > Shared Folders > Tasks > Permissions.

The Permissions dialog box appears.

3. Set the Permissions as follows, and click OK.

Accounts Permissions
Al Admin Role Open (Read, and Traverse)
AI Author Role Open (Read, and Traverse)

Al Consumer Role

BI Service Administrator (Owner)

Open (Read, and Traverse)
Full Control

4. Go to Shared Folders > Argus Insight > Permissions.

The Permissions dialog box appears.

5. Set the Permissions as follows, and click OK.

Accounts Permissions
Al Admin Role (Owner) Full Control
Al Author Role Full Control

AI Consumer Role

BI Service Administrator

Custom (Read, Traverse, Run Publisher
Report, Schedule Publisher Report, and
View Publisher Output)

Full Control
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Configuring the BusinessObjects XI
Environment

This chapter describes how to configure the BusinessObjects XI (BOXI) environment.
You must configure the BusinessObjects XI environment in the order specified in this
guide.

If you are using Cognos 10 instead of BusinessObjects XI, see Chapter 9 for
information about configuring the Cognos 10 environment for Argus Insight.

8.1 Checking Requirements

Before configuring the BusinessObjects environment, verify that you have installed all
required hardware and software. For more information, see Section 1.2, "Software and
Hardware Requirements."

In addition, if you are using the 64-bit version of Internet Information Services 7 (IIS 7),
you must ensure that:

= ASPNET is enabled.
»  The IIS advanced setting Enable 32-bit Applications is set to True.
»  The IIS advanced setting .NET Application Pool is set to Classic mode.

Note: Argus Insight 8.1.1 does not support multi-tenancy with its
reporting framework for BusinessObjects. There are no restrictions in
the multi-tenant Argus Insight database for the functioning of
BusinessObjects. The users can enhance the Argus Insight Reporting
framework or tweak BusinessObjects to support multi-tenancy in BO
reports.

8.2 Configuring the BusinessObjects Server

If the BusinessObjects application uses a different server from the Argus Insight
application, you must update the TNSNAMES.ora file as follows:

1. Copy the PRMART TNS entry from the Argus Insight Web Server.
2. Paste the entry into the TNSNAMES.ora file on the BusinessObjects Server.

Note: PRMART TNS entry must be mentioned in the
TNSNAMES.ora file for both 32-bit and 64-bit Oracle Client.
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If both applications use the same server and Oracle client, no modifications to the
TNSNAMES.ora file are required.

8.3 Configuring the Argus Insight Web Server

The following profile switches are available only when the BO WEB URL profile
switch is configured and Legacy Report profile switch is set to 1:

Holiday Schedule Management

Product Designated Medical Event Configuration
Measurable Suppliers

Site Configuration

Acceptable Delay Justification Configuration

To configure these profile switches, refer to Oracle Argus Insight 7.0.2 Installation Guide.
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Configuring the Cognos 10 Environment

You must configure the Cognos 10 environment in the order specified in this guide.

Before configuring the environment, verify that you have installed all required
hardware and software. For more information, see Section 1.2, "Software and
Hardware Requirements."

9.1 Setting Up Cognos Server and Configuration for New Installation

9.1.1 Configuring lIS 7.0 on the Cognos 10 Server

9.1.1.1 Checking that CGl or ISAPI Is Enabled in IIS

1.
2

Click Start.

Navigate to Administrative Tools, and select Server Manager.
The Server Manager screen appears.

In the Role Services section, click the Add Role Services link.
The Add Role Services dialog box appears.

Expand Application Development (Installed).

Verify that the CGI and ISAPI Extensions are listed as (Installed).

»  If these role services are not installed, select the appropriate check box, and
then click Install. Follow the instructions on the screen to complete the
installation.

= If these role services are already installed, click Cancel. The system returns to
the Server Manager screen.

9.1.1.2 Creating the Cognos 10 Virtual Directories

Navigate to Roles > Web Server (IIS), and select Internet Information Services
(IIS) Manager.

In Connections pane, expand the server node.

Expand Sites.

Right-click Default Web Site, and select Add Virtual Directory.
The Add Virtual Directory dialog box appears.
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5.

a. In the Alias field, enter Cognos 10.

b. In the Physical path field, enter the complete path to the Cognos 10 Web
content directory. The default path is:

drive:\Program Files\ibm\cognos\c10\webcontent
c. Click OK.

Right-click your newly-created Cognos 10 virtual directory, and select Add Virtual
Directory.

The Add Virtual Directory dialog box appears.
a. In the Alias field, enter cgi-bin.

b. In the Physical path field, enter the complete path to the Cognos 10 cgi-bin
directory. The default path is:

drive:\Program Files\ibm\cognos\c10\cgi-bin
c. Click OK.

9.1.1.3 Editing ISAPI or CGI Extensions

1.
2.
3.

On Server Manager screen, in the Connections pane, select the server node.
Double-click the ISAPI and CGI Restrictions icon.

In the Actions pane, click the Add.

The Edit ISAPI or CGI Restriction dialog box appears.

a. In the ISAPI or CGI path field, enter the path to either the cognos.cgi file or
the cognosisapi.dll file depending on which one you will use.

Note: For Argus Insight, Oracle recommends that you use
cognos.cgi. In addition, you may need to surround the path in double
quotes if it contains any spaces.

The default path for each file is as follows:
drive:\Program Files\ibm\cognos\c10\cgi-bin\cognosisapi.dll
drive:\Program Files\ibm\cognos\c10\cgi-bin\cognos.cgi

b. Select Allow extension path to execute check box.

c. Click OK.

Alternative Method

1.
2.
3.

In Connections pane, select the server node.

Double-click the ISAPI and CGI Restrictions icon.

In Actions pane, click the Edit Feature Settings.

The Edit ISAPI and CGI Restriction Settings dialog box appears.
Select the Allow unspecified CGI Modules check box.

Click OK.

9.1.1.4 Adding the Module Mapping

1.

Open the Internet Information Services (IIS) Manager.
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2. Expand the virtual directory folder, and click cgi-bin.
3. Double-click the Handler Mappings icon.
4. In the Actions pane, click the Add Module Mapping.
The Add Module Mapping dialog box appears.
a. In the Request path field, enter either *.cgi or *.dll as you need.
b. Inthe Module field, select either CGIModule or IsapiModule from the list.
c. Inthe Executable field, enter a value depending on the module you are using.

If you are using an ISAPI Module, you must enter the complete path to the
cognosisapi.dll. You can click the ellipsis icon to browse to the file location.

If you are using a CGI Module, you do not need to enter a value in the
Executable field.

d. In the Name field, enter a realistic name for this mapping. For example,
ISAPI-Cognos.

5. Click Request Restrictions.

a. Click the Mapping tab, and select Invoke handler only if request is mapped
to: File.

b. Click the Verbs tab, and select All verbs.
c. Click the Access tab, select Execute.
d. Click OK to save changes.
You return to the Add Module Mapping dialog box.
6. Click OK.

A message appears depending on the method used in Section 9.1.1.3, "Editing
ISAPI or CGI Extensions,".

7. Click Yes.
The new module mapping is added to the Module Mapping list.

9.1.1.5 Editing the Module Mapping

For Cognos Administration to function properly, you must manually edit the directive
that you added to the IIS configuration file in the previous step (see Section 9.1.1.4,
"Adding the Module Mapping").

To edit the module mapping;:
1. Navigate to the following folder:
COGNOS_HOME/c10/ cgi-bin

Note: Ensure that you have access permissions on the cgi-bin folder
so you can save the changes you make to the web.config file.

2. Open the web.config file for editing.
3. Locate the appropriate add name statement in the web.config file.

For CGI, locate this statement:
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<add name="CGI-cognos" path="*.cgi" verb="*" modules="CgiModule"
resourceType="Unspecified" />

For ISAPI, locate this statement:

<add name="ISAPI-Cognos" path="cognosisapi.dll" verb="*"
modules="IsapiModule" scriptProcessor="E:\Program Files\ibm\Cognos\C10\
cgi-bin\cognosisapi.dll" resourceType="Unspecified"
requireAccess="Execute" preCondition="bitness32" />

4. Add allowPathInfo="true" to the end of the statement.
For CGI:

<add name="CGI-cognos" path="*.cgi" verb="*" modules="CgiModule"
resourceType="Unspecified" allowPathInfo="true" />

For ISAPIL:

<add name="ISAPI-Cognos" path="cognosisapi.dll" verb="*"
modules="IsapiModule" scriptProcessor="E:\Program Files\ibm\Cognos\C10\
cgi-bin\cognosisapi.dll" resourceType="Unspecified"
requireAccess="Execute" preCondition="bitness32" allowPathInfo="true"/>

5. Save changes and close the web.config file.

9.1.1.6 Allowing CGI Application to Use Execute

1. Open the Internet Information Services (IIS) Manager.

2. Expand the virtual directory folder, and click the cgi-bin.

3. Double-click the Handler Mappings icon.

4. In the Actions pane, click the Edit Feature Permissions.
The Edit Features Permissions dialog box appears.

5. Select the Execute check box.

6. Click OK.

9.1.2 Configuring the Java Database Components
1. Navigate to the following Oracle installation path:

Oracle_Installation_Path\ product\Oracle_Version\client_1\sqldeveloper\jdbc\lib

2. For Oracle 11g client, copy the ojdbc5.jar file, and for Oracle 12c client, copy
ojdbcé.jar to the following location on the Cognos 10 environment:

Cognos_Installation_Path\c10\webapps\p2pd \web-inf\lib

9.1.3 Configuring Custom Java Authentication

9.1.3.1 Configuring Custom Java Authentication for Windows
1. Go to IBM Cognos Administration and stop the Cognos services.

2, Copy the CAM_AAA_JDBC_PowerReports.jar file from the following location:

\\Argus_Insight_Server\ Argus_Insight_Install_Path\java Authentication\JDBC_
PowerReport
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To the following location on the Cognos 10 Server:
\\Cognos_10_Install_Path\ c10\webapps\p2pd \WEB-INF\lib

Copy the JDBC_Config PowerReports.properties file from the following
location:

\\Argus_Insight_Server\ Argus_Insight_Install_Path\java Autherntication\
JDBC_PowerReport

To the following location on the Cognos 10 Server:
\\Cognos_10_Install_Path\ c10\Configuration
Define the configuration parameters:
a. Navigate to the following folder:
\\Cognos_10_Install_Path\ c10\Configuration
b. Open the JDBC_Config PowerReports.properties file for editing.

c. Modify the existing values of the following parameters only if the database
changed from the 7.0 database:

Parameter Value to Enter

Server Enter the IP address or the name of the Database Server.

SID Enter the instance/service name of the Argus Insight data mart.
Port Enter the database port number.

COGNOS_ Enter the header name in which Single Sign On user name will

SINGLE_SIGN_ be populated by SSO solution, that is, HEADER_OAM_
ON_HEADER REMOTE_USER.

d. Save and close the file.

Copy AlLini and ArgusSecureKey.ini from the following location:
\\<Argus_Insight_Server>\Windows

To the following location:
\\Cognos_10_Install_Path\C10\configuration

Navigate to the following folder:

Program Files\ibm\cognos\c10\bin\jre\6.0\lib\security
Backup local_policy.jar and US_export_policy.jar files.

Download the policy files corresponding to the version of installed JRE.

Note: To find the version of installed JRE:
= For Cognos 32 bit, go to bin/jre/version

= For Cognos 64 bit, go to bin64/jre/version

For example, to install policy files of JRE version 6, execute the following steps:
a. Go to the following URL:

https:/ /www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=
jecesdk
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b. Log in to the IBM site.

c. Select the files for Java 5.0 SR16, Java 6 SR13, Java 6 SR5 (]9 VM?2.6), Java 7 SR4,
and all later releases option, and click Continue.

d. ClickI agree, to agree to the license terms, and then select I confirm.

e. Click Download Now.

f. Download the files and extract into a folder.
Locate local_policy.jar and US_export_policy.jar files in the extracted folder.
Copy these jar files into the following folder:

drive:\Program Files\ibm\cognos\c10\bin(bin64 in case Cognos is 64 bit)\
jre\6.0\lib\security

9. Go to IBM Cognos Administration, and restart the Cognos services.

9.1.3.2 Configuring Custom Java Authentication for Linux
1. Go to IBM Cognos Administration and stop the Cognos services.

2, Copy the CAM_AAA_JDBC_PowerReports.jar file from the following location:

\\Argus_Insight_Server\ Argus_Insight_Install_Path\java Autherntication\
JDBC_PowerReport

To the following location on the Cognos 10 Server:
\\Cognos_10_Install_Path\ c10\webapps\p2pd \WEB-INF\lib

3. Copy the JDBC_Config PowerReports.properties file from the following
location:

\\Argus_Insight_Server\ Argus_Insight_Install_Path\java Autherntication\
JDBC_PowerReport

To the following location on the Cognos 10 Server:
\\Cognos_10_Install_Path\ c10\Configuration
4. Define the configuration parameters:
a. Navigate to the following folder:
\\Cognos_10_Install_Path\ c10\Configuration
b. Open the JDBC_Config PowerReports.properties file for editing.

c. Modify the existing values of the following parameters only if the database
changed from the 7.0 database:

Parameter Value to Enter

Server Enter the IP address or the name of the Database Server.

SID Enter the instance/service name of the Argus Insight data mart.
Port Enter the database port number.

COGNOS_ Enter the header name in which Single Sign On user name will
SINGLE_SIGN_ be populated by SSO solution, that is, HEADER_OAM_
ON_HEADER REMOTE_USER.

d. Save and close the file.

5. Copy AlLini and ArgusSecureKey.ini from the following location:
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\\<Argus_Insight_Server>\Windows
To the following location:
\\Cognos_10_Install_Path\C10\configuration

6. Navigate to the following folder:
JAVA_HOMEN\jre\6.0\lib\security

7. Backup local_policy.jar and US_export_policy.jar files.

8. Download the policy files corresponding to the version of installed JRE.

Note: To find the version of installed JRE, go to the JAVA_HOME
and check the folder name under the JRE folder.

For example, to install policy files of JRE version 6, execute the following steps:
a. Go to the following URL:

http:/ /www.oracle.com/technetwork/java/javase/downloads/jce-6-downlo
ad-429243 . html

b. Download local_policy.jar and US_export_policy.jar files in the extracted
folder.

c. Copy these jar files into the following folder:
JAVA_HOME\jre\6.0\lib\security
d. If the Replace Files dialog box appears, click Yes.

9. Go to IBM Cognos Administration, and restart the Cognos services.

9.1.4 Configuring the Cognos 10 Environment

9.1.4.1 Opening the IBM Cognos 10 Configuration Window

The IBM Cognos 10 Configuration screen is used to define environment group and
logging properties, security properties, and data access properties.

To open the IBM Cognos 10 Configuration screen:
1. Click Start.

2. Navigate to All Programs > IBM Cognos 10, and then select IBM Cognos
Configuration.

The IBM Cognos Configuration screen appears.

Note: The screens displayed during the Cognos 10 configuration are
labeled either IBM Cognos 10 or Cognos 10. Both labels refer to the
same Cognos configuration.

9.1.4.2 Setting the Security Properties for Cognos 10
1. Open the IBM Cognos 10 Configuration screen.

2. Navigate to Security > Authentication, and select Cognos.
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3. Set the Allow anonymous access? property to True.
4. Navigate to Security, and select IBM Cognos Application Firewall.
5. Set the Enable CAF validation? property to False.

9.1.4.3 Setting the Data Access Properties for Cognos 10
Open the IBM Cognos 10 Configuration screen.

2. Navigate to Data Access > Content Manager, right-click Content Store, and then
select Delete from the menu.

A confirmation messages appears.
3. Click Yes.

4. Navigate to Data Access, right-click Content Manager, select New resource, and
then select Database.

5. Complete the New Resource - Database dialog box as follows:
s In the Name field, enter CNTSTORE.
This is the name of the database resource.
s In the Type field, select Oracle database.
s Click OK.
The IBM Cognos Configuration screen appears.

The resource property for the database of the newly-created CNTSTORE resource
database appears.

6. Enter the value for the Database server and port number as:
Database_Server_Name:1521
where:

Database_Server_Name is the name of the server where your content store database
is stored.

7. Select User ID and password, and click the icon next to it.
The Value - User ID and password dialog box appears.
a. Inthe User ID field, enter the ID for the content store database user.
b. In the Password field, enter the password for the content store database user.
c. In the Confirm password field, re-enter the password for verification.

d. Click OK.

Note: The contents store database user is created in the Cognos
content store database. This user is given grants of Connect, Resource,
and Create View, along with Unlimited Tablespace Grant.

The character set of the Cognos content store database should only be
UTE

Make sure that the content store database entry is added in the
TNSNames.ora file on the Cognos 10 server.
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In the Service name field, enter the database instance name for the Cognos 10
repository.

9.1.4.4 Creating the Namespace for Argus Insight Authentication

1.
2.

Open the IBM Cognos 10 Configuration screen.

Navigate to Security, right-click Authentication, click New resource, and then
select Namespace.

Complete the New Resource — Namespace dialog box as follows:

s In the Name field, enter PowerReports.

s In the Type field, enter Custom Java Provider.

s Click OK.

The PowerReports - Namespace - Resource Properties screen appears.
Set the Namespace ID property to PowerReports.

Set the Java class name property to JDBCPowerReports.

9.1.4.5 Saving the Configuration and Starting the Cognos 10 Service

1.

Open the File menu, and select Save to save changes to the configuration settings.
An information dialog box appears and lists each task as it is performed.
Click Close when the system completes all the configuration tasks.

In the IBM Cognos Configuration screen, click the Start icon to run the Cognos 10
service.

File Edit VYiew Actions Help

b|m | GeEm|?

The system begins to run the IBM Cognos 10 service.

»  If there are no problems with the configuration, the system completes the test
phase and starts the IBM Cognos 10 service successfully.

»  If there are possible problems with the configuration, the system stops
running the service and displays a warning message. When you click OK to
acknowledge the warning message, the system opens another dialog box with
more information.

At this point:
»  For more information about the warnings and errors, click Details.
=  To stop the process, click Cancel.

If the warnings or errors are due to reasons other than mail server connection
failure, cancel the process and check your configuration again.

= Toignore the warnings and errors, and complete the process of starting the
IBM Cognos 10 service, click Continue.

For example, you may ignore warnings that the mail server cannot be reached
(see the previous illustration).

Configuring the Cognos 10 Environment 9-9



Setting Up Cognos Server and Configuration for New Installation

4.
5.

Click Close to exit.

Open the File menu, and select Exit to exit from the IBM Cognos 10 configuration.

9.1.5 Creating Cognos Data Source (PRMART)

1.

Log in to the Cognos 10.
The IBM Cognos 10 home page appears.

Note: If your security settings on the server do not permit you to
view the Cognos connection, add the site URL (http://Cognos_10_
Server/cognosl0) to the list of local intranet sites.

Under Administration section, click Administer IBM Cognos content.
The IBM Cognos Administration screen appears.

Click the Configuration tab.

Click Data Source Connections.

Click New Data Source icon.

The Specify a name and description - New Data Source Wizard screen appears.

Status Security Configuration Index Search

Oﬁ} Content Administration

[4]»
O Data Source Connections Directory > Cognos x ; L"’? Q

6.

10.

Enter the Name and Description of the data source, and click Next.
The Specify the connection - New Data Source Wizard screen appears.
Specify parameters for the connection, and click Next.
On the Configuration tab:
a. In SQL *Netconnect string: field, enter the connection string.

For example,

(DESCRIPTION=(ADDRESS_
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=<hostname>)(PORT=<Port>)))(
CONNECT_DATA=(SERVICE_NAME=<Service Name>)))

b. In the Signon section, select User ID check box, and enter details in the User
ID, Password, and Confirm password fields.

c. In the Testing section, click Test the connection...
Click Next, and specify the commands for connection.

For more information on Cognos commands, refer to Arqus Insight Extensibility
Guide > Section 5.3.2 Applying Arqus Data Security and Section 5.3.3 Applying
Enterprise Security.

Click Finish.
The PRMART data source is created.

9.1.6 Configuring Cognos Security
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9.1.6.1 Activating the PowerReports Namespace
1. Open the Cognos 10 configuration.

2. C(Click Start > All Programs > IBM Cognos 10, and then select IBM Cognos
Configuration.

The IBM Cognos Configuration screen appears.
3. Navigate to Security > Authentication, and then select Cognos.
The Cognos - Namespace - Resource properties screen appears.
4. Set the Allow Anonymous access? property to False.
5. From the File menu, select Save.
6. From the Actions menu, select Restart to restart the Cognos 10 service.

The status information about each task being performed during the restart
appears.

During the Cognos service restart, a warning message may appear.
7. Process any warning message as follows:
a. Click OK.
b. To obtain more information about the warning, click Details.
Depending on the type of warning:

— To ignore the warning and continue with the process of restarting the IBM
Cognos 10 service, click Continue.

For example, you may want to ignore a warning that the connection to the
mail server failed.

— To stop the restart process, click Cancel.

If the warnings are due to reasons other than a mail server connection failure,
you should stop the process, check your configuration, and then restart the
IBM Cognos 10 service.

8. Wait until the all the configuration tasks are processed and the status for each task
appears.

9. Click Close to exit the Cognos configuration.
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Note: Make sure that you remove the Everyone user group from the
Directory Administrator and System Administrator roles of Cognos.
Before doing this, make sure that you have a valid user as part of the
System Administrator role in Cognos.

If you have not added any user as part of the System Administrator
role in Cognos, then you have to add Everyone user group in System
Administrator roles of Cognos again.

To add the Everyone user group in the System Administrator role of
Cognos:

1. Connect to the Content Store database as the content store user.

2. Navigate to the following folder:
Cognos_10_Install_Path\C10\configuration\schemas\content

3. Run the AddSysAdminMember.sql script.

4. Commit the changes.

9.1.7 Configuring Enterprise-specific Roles and Permissions

1. Log in to the Cognos 10 Server as an administrator user.

2. Create an Enterprise-specific role for each enterprise. For example:
= ENT1_Role for Enterprise 1
= ENT2_Role for Enterprise 2

3. Add all users belonging to the specific enterprises to their respective roles. For
example:

s Add ENT1_user to ENT1_Role

Note: If a user is a member of multiple enterprises, the user must be
added to the roles for all the enterprises.

4. Create a folder in Public Folders for each enterprise. For example:
= ENT1_Folder for Enterprise 1
s ENT2_Folder for Enterprise 2

5. Select the required permissions of the Enterprise-specific role for the
Enterprise-specific folder. For example,

= Add ENT1_Role to the ENT1_Folder and provide the Read, Write, Execute,
and Traverse permissions on this folder.
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Configuring the OBIEE Environment

10.1 Pre-installation Configuration

Before integrating OBIEE with Argus Insight, make sure to complete the following
tasks:

1.
2

Install JDK 1.8 on the machine where Argus Insight is installed.

Since the data for analysis is based on Argus Mart schema and not the Insight
Mart schema, the TNS entry for the Argus Mart schema should be present in the
OBIEE 12c¢ home at the following path:

<obiee_home>\user_projects\domains\bi\config\fmwconfig\bienv\core\

Note: In this chapter, bi is referred as the domain name. This domain
name may differ based on your configuration.

<obiee_home>/user_projects/domains/bi

Set up the TNS for Oracle Client Home in the PATH variable.
Install Argus Mart.

When the installation is complete, the new tables, indexes, packages and all the
objects required for OBIEE are created in the Argus Mart schema.

Additionally, a read only user AM_BI_USER with read-only privileges on BI
Objects is created.

For detailed information on installing and upgrading Argus Mart schema, refer to
Oracle Argus Mart Installation and Administration Guide.

10.2 Configuring the OBIEE Repository and Web Catalog using the BAR

File

Oracle Business Intelligence Application Archive (BAR) file is a compressed archive
file that contains a cohesive set of Bl metadata artifacts (data model, content model,
and authorization model). When deploying BI application from one server to another
you can use these BAR files to transfer the metadata instead of transferring the RPD,
Catalog, and the Security Model separately.

A BAR file contains the following BI application module artifacts:
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s Data model metadata for the Oracle BI Server. This metadata is xml-based but
functionally equivalent to a .RPD file.

= Presentation Services catalog metadata for a service instance.

= Security policy metadata containing application role and application role
memberships, and permission and permission set grants for a service instance.

= A manifest file declaring the dependencies of the BAR file.

Note: Importing a BAR file replaces all the Catalog files, RPD files,
and the Security Model in an existing OBIEE instance with any
customization.

It is recommended that the BAR file import is done on a new OBIEE
instance.

10.2.1 Importing the BAR file in an existing OBIEE instance

Before importing the BAR File, make sure:
= OBIEE 12.2.1 is installed

s The Administrator Console is up and running
(validate it from http://<machinename>.<port>/console)
»  The Enterprise Manager (Fusion Middleware Control) is up and running

(validate it from http://<machinename>.<port>/em)

To import the BAR file:

1. Copy the BAR file from <Al HOME>OBIEE\BAR File\ssi.bar to a local folder on
the machine where the OBIEE is installed.

For example, copy the file at C:\AIOBIEE\instance\import.
2. Login to the Enterprise Manager with the WebLogic credentials.
3. Click Target Navigation.

== biail ©®

T

The Target Navigation drop-down menu appears.

& WebLogic Domain

4. Go to Business Intelligence > biinstance.
The Business Intelligence Instance screen appears.

5. From the Availability tab, select Processes, and click Stop All.
A confirmation dialog box appears.

6. Click Yes.
All the running processes are stopped.

7. Go to the command prompt, and start the WebLogic Scripting Tool (using
wlst.cmd on Windows, and wlst.sh on Unix/Linux) from the following path:

<OracleBI Home>\Middleware\oracle_common\common\bin
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10.
11.

12.

To know the BI Service Instance key, type the following command, and press
Enter.

> listBlServicelnstances(domainHome)

where, Domain Home is the directory of the BI Install domain, the default path is:
<obiee_home>/user_projects/domains/bi

The Key appears at the end of the command.

For example, ssi appears as the Key.

To import the BAR file, execute the following command:

> importServicelnstance(’Domain Home',’BI Servicelnstance key’, 'Bar file to import’)

For example, importServicelnstance(’C:/Oracle/Middleware/Oracle_Home/user_
projects/domains/bi’, 'ssi’, 'C:/AIOBIEE/instance/import/ssi.bar’)

When the import of BAR file is complete, exit WLST using the exit () command.

Go to Enterprise Manager, from the Availability tab, select Processes, and click
Start All

A confirmation dialog box appears.
Click Yes.
The BAR file imports the RPD, Catalog and the Security model.

Note: All the WLST commands are case sensitive.

To start the WebLogic Scripting Tool on Unix or Linux, use wlst.sh
command, rest all of the commands mentioned in the procedure
remains same.

While executing the WLST commands on Windows server, you must
use forward slash (/) to avoid any error messages. For example:

C:/AIBOEE/instance/import/ssi.bar

To check if the BAR file has imported RPD, Catalog, and the Security Model:

1.

2.

To verify the Roles and Policies imported by BAR file in the Enterprise Manager,
go to Business Intelligence Instance > Security > Application Roles and
Application Policies.

The following roles are imported as default application roles:
s Al Admin Role

= Al Author Role

= Al Consumer Role

For a list of privileges assigned to these roles, refer to Section 10.6, "OBIEE Default
Application Roles."

To modify the Connection Pool Settings:

a. From the following path, right click the admintool.cmd file, and click Run as
Administrator.

<obiee_home>\user_projects\domains\bi\Dbitools\bin

The BI Admin Tool opens.
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b. To open the RPD, select the online mode, and enter the WebLogic user
credentials.

Note: To open the RPD in online mode, you must set the Open
Database Connectivity (ODBC). Refer to the Appendix A, "Creating
ODBC Connection for OBIEE Administration Tool."

If OBIEE is installed on the Unix or Linux machine, set up the Oracle
Business Intelligence Developer Client Tool on any Windows machine
to access the BI Administration Tool.

c. Click the Connection Pool, and modify the Data source name, User name,
and Password.

Modify both the connection pools: AISOOBIEE_CP and AIS0OBIEE_CP_
InitBlocks.

Check-in the changes, and save the RPD.
Ignore the warning messages that appear during the consistency check.

Create OBIEE Groups and Users. (See Section 10.4, "Creating Users and Groups in
OBIEE")

Go to Catalog, and set the folder level permissions for the OBIEE Groups. (See
Section 10.5, "OBIEE Catalog Folder-level Permissions")

To view and administer privileges for the Oracle Business Intelligence
components, login to OBIEE Analytics with WebLogic user credentials.

Go to Administration > Security > Manage Privileges.

For a list of privileges assigned to these roles, refer to Section 10.6, "OBIEE Default
Application Roles."

Go to Administration > Maintenance and Troubleshooting, and click Reload Files
and Metadata.

To use the Al Aggregate Analysis Subject area and Dashboard, login with a valid
user credentials.

10.2.2 Importing the BAR file when creating a new OBIEE Instance

1.

Copy the BAR file from <Al HOME>OBIEE\BAR File\ssi.bar to a local folder on
the machine where the OBIEE is installed.

When creating an instance in OBIEE 12c, enter the BAR file path in the Path field
of the OBIEE Initial Application wizard screen.

When the installation is completed successfully, and all the processes are up, open
the RPD in online mode, and change the Connection Pool Settings. (See To check
if the BAR file has imported RPD, Catalog, and the Security Model: > Step 2)

Check-in the changes, and save the RPD.
Ignore the warnings that appear during the consistency check
From the Enterprise Manager > Stop and Start the Bl processes.

Create OBIEE Groups and Users. (See Section 10.4, "Creating Users and Groups in
OBIEE")
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10.

Go to Catalog, and set the folder level permissions for the OBIEE Groups. (See
Section 10.5, "OBIEE Catalog Folder-level Permissions")

To view and administer privileges for the Oracle Business Intelligence
components, login to OBIEE Analytics with WebLogic user credentials.

Go to Administration > Security > Manage Privileges.

For a list of privileges assigned to these roles, refer to Section 10.6, "OBIEE Default
Application Roles."

Go to Administration > Maintenance and Troubleshooting, and click Reload Files
and Metadata.

To use the Al Aggregate Analysis Subject area and Dashboard, login with a valid
user credentials.

10.3 Configuring OBIEE Repository and Web Catalog Manually

1.

10.

Copy the RPD, and Catalog files from <Al HOME>OBIEE\RPD\ and <Al
HOME>OBIEE\ Catalog folders to a machine where the OBIEE is installed.

Open the RPD Admin tool in offline mode from the following path:
<obiee_home>\user_projects\domains\bi\bitools\bin\ admintool.cmd
The default Repository Password is insight123.

Change the Connection Pool Settings. (See To check if the BAR file has imported
RPD, Catalog, and the Security Model: > Step 2)

Save the changes, and close the RPD.

From the command prompt:

a. Navigate to the <obiee_home>\user_projects\domains\bi\bitools\bin
b. Run the following command:

data-model-cmd.cmd uploadrpd -1 <RPDname> [-W <RPDpwd>] -U <cred_
username> [-P <cred_password>] -SI <service_instance>

For example, data-model-cmd.cmd uploadrpd -1
C:\AIOBIEE\RPD\Argusinsight.rpd -W insight123 -U weblogic -P weblogicl -SI
ssi

Login to the Enterprise Manager with the WebLogic credentials.
Click Target Navigation.

=== biail O

T

The Target Navigation drop-down menu appears.

& WebLogic Domain

Go to Business Intelligence > biinstance.

The Business Intelligence Instance screen appears.

From the Availability tab, select Processes, and click Stop All.
A confirmation dialog box appears.

Click Yes.
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11.

12.

13.
14.

15.

16.

17.

18.

19.

20.

All the running processes are stopped.
Go to Catalog\argusinsight\root\shared folder:
a. Copy argus+insight folder, and argus+insight.atr file.

b. Paste in <obiee_home>\user_projects\domains\bi\bidata\service_
instances \ssi\metadata\content\catalog\root\shared folder.

Go to Enterprise Manager, from the Availability tab, select Processes, and click
Start All.

A confirmation dialog box appears.
Click Yes.

Create User Groups and Users manually in Admin Console. (See Section 10.4.1,
"Creating Users and Groups in WebLogic Server.").

Create Roles and policies manually in Enterprise Manager. (See Section 10.4.2,
"Creating Roles and Policies with Fusion Middleware Control.")

To view and administer privileges for the Oracle Business Intelligence
components, login to OBIEE Analytics with WebLogic user credentials.

Go to Administration > Security > Manage Privileges.

For a list of privileges assigned to these roles, refer to Section 10.6, "OBIEE Default
Application Roles."

Go to Catalog, and set the folder level permissions for the OBIEE Groups. (See
Section 10.5, "OBIEE Catalog Folder-level Permissions")

Go to Administration > Maintenance and Troubleshooting, and click Reload Files
and Metadata.

To use the AI Aggregate Analysis Subject area and Dashboard, login with a valid
user credentials.

Note: All the WLST commands are case sensitive.

To start the WebLogic Scripting Tool on Unix or Linux, use wlst.sh
command, rest all of the commands mentioned in the procedure
remains same.

While executing the WLST commands on Windows server, you must
use forward slash (/) to avoid any error messages. For example:

C:/AIBOEE/instance/import/ssi.bar

10.4 Creating Users and Groups in OBIEE

10.4.1 Creating Users and Groups in WebLogic Server

To create users and groups in OBIEE:

1.
2.
3.

Open the WebLogic Administration Console.
Navigate to Security Realms > myrealm > Users and Groups > Groups tab.

From the Groups section, and click New.
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The Create a New Group dialog box appears.

4. Create the following groups by entering the Name and Description, and click OK.
s AIAdminGroup
s AJAuthorGroup

s AlConsumerGroup

To create users in the Fusion Middleware Control:
1. Open the WebLogic Administration Console.

2. Navigate to Security Realms > myrealm > Users and Groups > Users.
3. From the Users section, and click New.

The Create a New User dialog box appears.
4. Enter the parameters, and click OK.

5. To assign a group to the user, from the Groups tab, select a Group, and click Save.

10.4.2 Creating Roles and Policies with Fusion Middleware Control

Note: This section is applicable only when you manually upload the
RPD file and Catalog. For more details, refer to Section 10.3,
"Configuring OBIEE Repository and Web Catalog Manually.".

To create new application roles:
1. Login to Fusion Middleware Control Enterprise Manager.

2. Go to WebLogic Domain > Security > Application Roles.
The Application Roles dialog box appears.
3. From the Application Stripe drop-down list, select OBI, and click Search .
The default role available in clean slate installation appears.
4. Click Create.
The Create Application Role dialog box appears.
5. In the Role Name field, enter AIAdminRole.
6. From the Members section, click +Add.
The Add Principal dialog box appears.
7. From the Type drop-down list, select Group, and click Search.
A list of principals appears.
8. From the list of Searched Principals, select ATAdminGroup, and click OK.
9. From the Members section, click +Add.
The Add Principal dialog box appears.
10. From the Type drop-down list, select Application Role, and click Search.
A list of principals appears.

11. From the list of Searched Principals, select BIServiceAdministrator , and click OK.
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The Membership for AIAdminRole appears.

12. Repeat from Step 4 to Step 11 to create other Roles and add Member to these roles
as listed in the table below.

Role Application Roles

AI Admin Role AI Admin Group
Weblogic

AI Author Role AI Author Group
AI Admin Group

AI Consumer Role AI Consumer Group
Al Author Group
AI Admin Group

Note: For more details, refer Section 2.8.3.1 Creating Application Roles
Using Fusion Middleware Control in
https://docs.oracle.com/middleware/1221/bip/BIPAD.pdf

To create new application policy:
1. Login to Fusion Middleware Control Enterprise Manager.

2. Go to WebLogic Domain > Security > Application Policies.
The Application Policies screen appears.
3. To create a new application policy, click Create.
The Create Application Grant dialog box appears.
4. From the Grantee section, click +Add.
The Add Principal dialog box appears.
5. From the Type drop-down list, select Application Role, and click Search " .
6. From the list of Searched Principals, select AIAdminRole, and click OK.
7. From the Permissions section, click +Add.
The Add Permission dialog box appears.
8. Select the Resource Types radio button.

9. From the Resource Type drop-down list, select oracle.bi.publisher.permission,
and click Search.

10. From the Search Results, select oracle.bi.publisher.permission (BIP Administer
Server), and click Continue.

The Add Permission dialog box appears.
11. For Permission Actions, select All (_all_), and click Select.

12. Repeat from Step 4 to Step 11, to add the following;:
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Policy Permission
Name/Principal Resource Type Resource Name Actions
Al Admin Role oracle.bi.catalog * manage
oracle.bi.server.permission  oracle.bi.servermanageRep _all_
ositories
oracle.bi.presentation.catalo oracle.bi.presentation.catalo _all_
gmanager.permission gmanger.manageCatalog
oracle.bi.delivers.job oracle.bi.delivers.job manage
oracle.bi.publisher.permissi oracle.bi.publisher.administ _all_
on erServer
oracle.bi.repository oracle.bi.repository manage
oracle.bi.scheduler.permissi oracle.bi.scheduler.manage] _all_
on obs
oracle.bi.publisher.permissi oracle.bi.publisher.developR _all_
on eport
oracle.bi.publisher.permissi oracle.bi.publisher.develop _all_
on DataModel
AI Author Role oracle.bi.publisher.permissi  oracle.bi.publisher.developR _all_
on eport
oracle.bi.publisher.permissi oracle.bi.publisher.develop _all_
on DataModel
oracle.bi.tech.visualanalyzer oracle.bi.tech.visualanalyzer *
.permission .general Access
oracle.bi.delivers.job * schedule
AI Consumer oracle.bi.publisher.permissi oracle.bi.publisher.schedule _all_
Role on Report
oracle.bi.publisher.permissi oracle.bi.publisher.runRepor _all_
on tOnline
oracle.bi.publisher.permissi oracle.bi.publisher.accessRe _all_
on portOutput
oracle.bi.publisher.permissi oracle.bi.publisher.accessOn _all_
on lineReportAnalyzer
ESSMetadataPermission oracle.bip.ess.JobDefinition. READ,EXECUT
EssBipJob E
oracle.bi.publisher.permissi oracle.bi.publisher.accessExc _all_

on

elReportAnalyzer

Note:

Policies Using Fusion Middleware Control from
https://docs.oracle.com/middleware/1221/bip/BIPAD.pdf.

For a list of privileges for BIApplication Role specified above, refer to
Section 10.6, "OBIEE Default Application Roles."

For more details, refer to Section 2.8.3.2 Creating Application

10.5 OBIEE Catalog Folder-level Permissions

1. Login to OBIEE Analytics with the WebLogic user credentials.
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2. Go to Catalog > Shared Folders > Tasks > Permissions.
The Permissions dialog box appears.

3. Set the Permissions as follows:

Accounts Permissions

Al Admin Role Full Control

Al Author Role Full Control

AI Consumer Role Open (Read, and Traverse)
BI Service Administrator (Owner) Full Control

a. Select Apply Permissions to sub-folders.
b. Select Permissions to items within folder.
c. Click OK.
4. Go to Shared Folders > Argus Insight > Permissions.
The Permissions dialog box appears.

5. Set the Permissions as follows:

Accounts Permissions

Al Admin Role (Owner) Full Control

Al Author Role Full Control

Al Consumer Role Custom (Read, Traverse, Run Publisher
Report, Schedule Publisher Report, and
View Publisher Output)

BI Service Administrator Full Control

a. Select Apply Permissions to sub-folders.
b. Select Permissions to items within folder.

c. Click OK.

Setting Permission through the Catalog Manager
If you are unable to set the folder level permissions, refer to the OBIEE Catalog
manager.

1. Open the catalog manager from the following path, right-click runcat.cmd, and
click Run as administrator.

<obiee_home >\user_projects \domains\ <instance_name>\bitools\bin\runcat.cmd
2. Open the catalog in offline mode from the catalog path.
For example:

C:\Oracle\Middleware\ Oracle_Home\user_projects\domains\bil \bidata\service_
instances\ssi\metadata\content\catalog\

3. Click the '/' folder.
In the right pane, the Shared folder appears.
a. Right-click the Shared folder, and select Permissions.
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The Permissions dialog box appears.

b. Set the Permissions as follows:

Accounts Permissions

Al Admin Role (Owner) Full Control

Al Author Role Full Control

Al Consumer Role Custom (Read, Traverse, Run Publisher
Report, Schedule Publisher Report, and
View Publisher Output)

BI Service Administrator Full Control

c. Select Apply Permissions to sub-folders.
d. Select Permissions to items within folder.
e. Click OK.

4. Right-click the Shared folder > Properties, set the owner as
BiServiceAdministrator, and click OK.

5. From the tree structure (on the left side), click Shared folder.
Argus Insight folder appears on the right side.
a. Right-click Argus Insight folder, and click Permissions.
The Permissions dialog box appears.
b. Set the permissions as in Step 3 b to 3 d.
c. Click OK.

6. Right-click Argus Insight folder > Properties, set the owner as AIAdminRole, and
click OK.

7. Login to OBIEE Analytics, and check the folder level permissions.

8. Go to Administration > Maintenance and Troubleshooting, and click Reload Files
and Metadata.

10.6 OBIEE Default Application Roles

To view and administer privileges of Oracle Business Intelligence components:
1. Login to OBIEE Analytics with WebLogic user credentials.

2. Go to Administration > Security > Manage Privileges.

Note: Create these privileges only when you manually upload the

RPD and Catalog.
You do not need to create these privileges when you import the BAR
file.

Component Privilege Default Role Granted

Access Access to Dashboards Al Consumer Role, BI Service

Administrator
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Component Privilege Default Role Granted

Access Access to Answers Al Author Role, BI Service Administrator

Access Access to BI Composer Al Author Role, BI Service Administrator

Access Access to Delivers Al Author Role, BI Service Administrator

Access Access to Briefing Books Al Consumer Role, BI Service
Administrator

Access Access to Mobile Al Consumer Role, Bl Service
Administrator

Access Access to Administration Al Admin Role, BI Service Administrator

Access Access to Segments Al Consumer Role, BI Service
Administrator

Access Access to Segment Trees Al Author Role, BI Service Administrator

Access Access to List Formats Al Author Role, BI Service Administrator

Access Access to Metadata Dictionary Al Author Role, BI Service Administrator

Access Access to Oracle BI for Microsoft Office Al Consumer Role, BI Service
Administrator

Access Access to Oracle BI Client Installer Al Consumer Role, BI Service
Administrator

Access Catalog Preview Pane Ul Al Consumer Role, BI Service
Administrator

Access Access to Export Al Consumer Role, BI Service
Administrator

Access Access to KPI Builder Al Author Role, BI Service Administrator

Access Access to Scorecard Al Consumer Role, Bl Service
Administrator

Actions Create Navigate Actions Al Consumer Role, BI Service
Administrator

Actions Create Invoke Actions Al Author Role, BI Service Administrator

Actions Save Actions containing embedded HTML AI Admin Role, BI Service Administrator

Admin: Catalog
Admin: Catalog
Admin: General
Admin: General
Admin: General
Admin: General
Admin: General
Admin: General
Admin: General
Admin: General
Admin: General
Admin: General

Admin: General

Change Permissions
Toggle Maintenance Mode
Manage Sessions

Create Dashboards

See sessions IDs

Change Log Configuration
Issue SQL Directly

View System Information
Performance Monitor
Manage Agent Sessions
Manage Device Types
Manage Map Data

See privileged errors
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Component

Privilege

Default Role Granted

Admin: General

Admin: General
Admin: General
Admin: General
Admin: General
Admin: Security
Admin: Security
Admin: Security

Admin: Security
Admin: Security
Admin: Security
Admin: Security

Briefing Book
Briefing Book

Briefing Book
Catalog

Catalog
Catalog
Catalog
Catalog
Catalog
Catalog
Catalog
Catalog
Conditions

Dashboards

Dashboards
Dashboards

Dashboards

Dashboards

See SQL issued in errors

Manage Global Variables
Diagnose BI Server Query
Manage Marketing Jobs

Manage Marketing Defaults
Manage Catalog Accounts
Manage Privileges

Set Ownership of Catalog Objects

User Population - Can List Users
User Population - Can List Catalog Groups

User Population - Can List Application
Roles

Access to Permissions Dialog

Add To or Edit a Briefing Book

Download Briefing Book
Add to Snapshot Briefing Book

Personal Storage (My Folders and My
Dashboard)

Reload Metadata

See Hidden Items

Create Folders

Archive Catalog
Unarchive Catalog
Upload Files

Perform Global Search
Perform Extended Search
Create Conditions

Save Customizations

Assign Default Customizations

Create Bookmark Links
Create Prompted Links

Export Entire Dashboard To Excel

Al Consumer Role, BI Service
Administrator

Al Admin Role, BI Service Administrator
Denied: Authenticated User

Al Author Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Admin Role, BI Service Administrator

Al Consumer Role, BI Service
Administrator, BI System

Al Consumer Role, BI Service
Administrator, BI System

Al Consumer Role, BI Service
Administrator, BI System

Al Consumer Role, BI Service
Administrator

Al Author Role, BI Service Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Admin Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator

Al Consumer Role, BI Service
Administrator

Al Author Role, BI Service Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator
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Component Privilege Default Role Granted

Dashboards Export Single Dashboard Page To Excel Al Consumer Role, BI Service
Administrator

Formatting Save System-Wide Column Formats Al Admin Role, BI Service Administrator

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header

Home and Header
Home and Header
Home and Header
Home and Header

My Account

My Account

My Account

Answers
Answers
Answers
Answers
Answers

Answers

Access Home Page
Access Catalog Ul
Access Catalog Search Ul
Access Rapid Search Ul
Simple Search Field
Advanced Search Link
Open Menu

New Menu

Help Menu
Dashboards Menu
Favorites Menu

My Account Link
Custom Links

Access Administration Menu
Access User & Role Admin
Access Modeler

Access Data Loader

Access to My Account
Change Preferences
Change Delivery Options

Create Views
Create Prompts
Access Advanced Tab

Edit Column Formulas

Save Content with HTML Markup

Enter XML and Logical SQL
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Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Denied: Authenticated User
Denied: Authenticated User
Denied: Authenticated User
Denied: Authenticated User

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Consumer Role, BI Service
Administrator

Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Admin Role, BI Service Administrator

Al Author Role, BI Service Administrator
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Component Privilege Default Role Granted

Answers Edit Direct Database Analysis Al Admin Role, BI Service Administrator

Answers Create Analysis From Simple SQL Al Admin Role, BI Service Administrator

Answers Create Advanced Filters and Set Al Author Role, BI Service Administrator

Operations

Answers Save Filters Al Author Role, BI Service Administrator

Answers Save Column Al Author Role, BI Service Administrator

Answers Add EVALUATE_PREDICATE Function Al Author Role, BI Service Administrator

Answers Execute Direct Database Analysis Al Admin Role, BI Service Administrator

Answers Upload Images Al Author Role, BI Service Administrator

Delivers Create Agents Al Author Role, BI Service Administrator

Delivers Publish Agents for Subscription Al Author Role, BI Service Administrator

Delivers Deliver Agents to Specific or Dynamically Al Admin Role, BI Service Administrator

Determined Users

Delivers Chain Agents Al Author Role, BI Service Administrator

Delivers Modify Current Subscriptions for Agents Al Admin Role, BI Service Administrator

Proxy Act As Proxy Denied: Authenticated User

RSS Feeds Access to RSS Feeds Al Consumer Role, BI Service
Administrator

Scorecard Create/Edit Scorecards Al Author Role, BI Service Administrator

Scorecard View Scorecards Al Consumer Role, Bl Service
Administrator

Scorecard Create/Edit Objectives Al Author Role, BI Service Administrator

Scorecard Create/Edit Initiatives Al Author Role, BI Service Administrator

Scorecard Create Views Al Author Role, BI Service Administrator

Scorecard Create/Edit Causes And Effects Linkages ~ AI Author Role, BI Service Administrator

Scorecard Create/Edit Perspectives Al Author Role, BI Service Administrator

Scorecard Add Annotations Al Consumer Role, BI Service
Administrator

Scorecard Override Status Al Consumer Role, BI Service
Administrator

Scorecard Create/Edit KPIs Al Author Role, BI Service Administrator

Scorecard Write Back to Database for KPI Al Consumer Role, BI Service
Administrator

Scorecard Add Scorecard Views To Dashboards Al Consumer Role, BI Service

List Formats
List Formats
List Formats
List Formats
Segmentation

Segmentation

Create List Formats

Create Headers and Footers

Access Options Tab

Add/Remove List Format Columns
Create Segments

Create Segment Trees

Administrator

Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Admin Role, BI Service Administrator
Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator
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Component Privilege Default Role Granted
Segmentation Create/Purge Saved Result Sets Al Admin Role, BI Service Administrator
Segmentation Access Segment Advanced Options Tab Al Admin Role, BI Service Administrator
Segmentation Access Segment Tree Advanced Options Al Admin Role, BI Service Administrator
Tab
Segmentation Change Target Levels within Segment Al Author Role, BI Service Administrator
Designer
Mobile Enable Local Content Al Consumer Role, BI Service
Administrator
Mobile Enable Search Al Consumer Role, Bl Service
Administrator
SOAP Access SOAP Al Consumer Role, BI Service
Administrator, BI System
SOAP Impersonate as system user BI System
SOAP Access MetadataService Service Al Consumer Role, Bl Service
Administrator, BI System
SOAP Access Scorecard AssessmentService Al Consumer Role, BI Service
Service Administrator, BI System
SOAP Access MsgdbService Service AI Consumer Role, BI Service
Administrator, BI System
SOAP Access ReportEditingService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access KPIAssessmentService Service Al Consumer Role, Bl Service
Administrator, BI System
SOAP Access ConditionEvaluationService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access SecurityService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access Tenant Information BI System
SOAP Access SchedulerService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access DashboardService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access ScorecardMetadataService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access JobManagementService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access CatalogIndexingService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access UserPersonalizationService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access AnalysisExportViewsService Al Consumer Role, BI Service
Service Administrator
SOAP Access CatalogService Service Al Consumer Role, BI Service
Administrator, BI System
SOAP Access AdministrationSOAPService Al Consumer Role, BI Service

Service
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Component Privilege Default Role Granted

SOAP Access HtmlViewService Service Al Consumer Role, BI Service
Administrator, BI System

SOAP Access XmlGenerationService Service Al Consumer Role, BI Service
Administrator, BI System

SOAP Access IBotService Service Al Consumer Role, BI Service
Administrator, BI System

Subject Area: Access within Oracle BI Answers Al Author Role, BI Service Administrator

"Al-Aggregate

Analysis"

View Canvas

View Column
Selector

View Compound
Layout

View Contribution
Wheel

View Graph
View Funnel
View Gauge
View Micro Chart
View Filters

View Dashboard
Prompt

View Performance
Tile

View Heat Matrix
View Static Text
View Javascript view
View Legend

View Map

View Narrative
View No Results
View Pivot Table

View Generic Plugin
View

View Report Prompt
View Create Segment
View Selection Steps
View Logical SQL
View Table

View Create Target
List

View Ticker

Add/Edit Canvas View
Add/Edit Column Selector View

Add/Edit Compound Layout View
Add/Edit Contribution Wheel View

Add/Edit Graph View

Add/Edit Funnel View

Add/Edit Gauge View

Add/Edit Micro Chart View
Add/Edit Filters View

Add/Edit Dashboard Prompt View

Add/Edit Performance Tile View

Add/Edit Heat Matrix View
Add/Edit Static Text View

Edit Javascript View

Add/Edit Legend View

Add/Edit Map View

Add/Edit Narrative View

Add/Edit No Results View
Add/Edit Pivot Table View
Add/Edit Generic Plugin View View

Add/Edit Report Prompt View
Add/Edit Create Segment View
Add/Edit Selection Steps View
Add/Edit Logical SQL View
Add/Edit Table View

Add/Edit Create Target List View

Add/Edit Ticker View

Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
AI Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator
Al Author Role, BI Service Administrator

Al Author Role, BI Service Administrator

Configuring the OBIEE Environment

10-17



OBIEE Default Application Roles

Component Privilege Default Role Granted

View Title Add/Edit Title View Al Author Role, BI Service Administrator
View Treemap Add/Edit Treemap View Al Author Role, BI Service Administrator
View Trellis Add/Edit Trellis View Al Author Role, BI Service Administrator

View View Selector
Write Back
Write Back

Add/Edit View Selector View
Manage Write Back
Write Back to Database

Al Author Role, BI Service Administrator
Al Admin Role, BI Service Administrator

Denied: Authenticated User
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Managing the Argus Insight
Cryptography Key

This chapter describes how to update the cryptography key in Argus Insight after the
key has been updated in Argus Safety.

11.1 Updating the Cryptography Key and Re-encrypt

After the cryptography key has been updated in Argus Safety, you must update the
cryptography key in Argus Insight. This process will update all the required
passwords in Argus Insight using the new key.

To update the cryptography key and regenerate passwords:

1.
2.
3.

9.

Log in to the Argus Insight client.
Click Start.

Navigate to Programs > Oracle > Argus Insight, and then select Cryptography
Key Management.

The Argus Insight Key Management screen appears.
Enter the following parameters and click Validate.
a. DBA user name

b. DBA user password

c. Argus Insight database name

After successful authentication, the Argus Insight Key Management - Options to
re-crypt and change password are enabled.

Select Re-Encrypt Existing Passwords.
Select Apply New Secure Key check box.

In the Enter Current Argus Secure Key field, enter the existing Argus Insight
Secure Key.

In the Enter New Argus Secure Key field, enter the new Argus Insight Secure Key
from the Argus Safety Server.

You may copy UserCryptoKey from the ArgusSecureKey.ini file, which is present
on all Argus Safety Servers in C:\Windows folder. Make sure you use the exact
key used by the corresponding Argus Safety Server.

Enter justification.

10. Click Execute to start the password regeneration process.
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11.

When the password regeneration process completes, the status of the regeneration
process (success or fail) appears.

Click Reset to enable the Execute button again.

11.2 Updating the Cryptography Key and Change Password

To change all Argus Insight related passwords you can use Key Management Tool. You
can change password with the existing cryptography key or use the new cryptography
key. If the new cryptography key is used then the same key will be updated in
ArgusSecureKey.ini.

To change the cryptography key and change passwords:

1.
2
3.

10.

11.

Log in to the Argus Insight client.
Click Start.

Navigate to Programs > Oracle > Argus Insight, and then select Cryptography
Key Management.

Or, go to: C\Program Files (x86)\Oracle\ ArgusInsight\ Bin
The Argus Insight Key Management screen appears.
Enter the following parameters and click Validate.

a. DBA user name

b. DBA user password

c. Argus Insight database name

After successful authentication, the Argus Insight Key Management - Options to
re-crypt and change password are enabled.

Select Change Passwords.
To change the cryptographic key, select Apply New Secure Key check box.

In the Enter Current Argus Secure Key field, enter the existing Argus Insight
Secure Key.

In the Enter New Argus Secure Key field, enter the new Argus Insight Secure Key
from the Argus Safety Server.

You may copy UserCryptoKey from the ArgusSecureKey.ini file, which is present
on all Argus Safety Servers in C:\Windows folder. Make sure you use the exact
key used by the corresponding Argus Safety Server.

Enter the Argus Insight Application User Password (deselect this options if you do
not want to change password).

Enter APR_USER password (deselect this option if you do not want to change
password in the ALINI).

Enter the password for Argus Mart application users.
If Argus Mart is not configured then this section will be disabled.
= You can provide individual password for all enterprises.

= To set same password for all the enterprises, select Set same Password for all
enterprise.

s Deselect the check box for which enterprise you do not want to change
password.

11-2 Oracle Argus Insight Installation Guide



Restarting 1IS and Running ETL

= Deselect all the check boxes if you do not want to change Argus Mart
password.

12. Enter justification.
13. Click Execute to start the password change process.

When the password change process completes, the status of the process (success or
fail) appears.

14. Click Reset to enable the Execute button again.

11.3 Copying Initialization Files to Other Servers

After you change the cryptography key using the Key Management tool, you must
manually copy the ALini and Argus SecureKey.ini initialization files from the
C:\Windows folder of the Argus Insight Web Server to the following folders:

= C:\Windows of all Cognos Servers
s C:\Windows of all Argus Insight Web Servers

You must copy the ALini and Argus SecureKey.ini files to keep the cryptography key
and the APR_USER password in sync on all the servers. In case these files are not
copied, the Cognos Server or any other Argus Insight Web Server will not function.

11.4 Restarting IIS and Running ETL

After you change the cryptography key, you must complete the following steps on the
Argus Insight Web Server to reflect the changes:

1. Restart the Internet Information Services (IIS).

2. Run the incremental ETL.
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Uninstalling the Argus Insight Application

To uninstall Argus Insight from the Web Server:

1.

2
3.
4

Log in to the Argus Insight Web Server as a user with administrator privileges.
Navigate to Control Panel >Programs > Program and Features.

Select Uninstall or change a program.

Right-click Argus Insight, and click Uninstall.

The Argus Insight wizard is initiated and the Welcome screen appears with
options to modify, verify, and remove programs.

Select Remove, and click Next.

Click Yes.

The Argus Insight application is uninstalled completely and a message appears
when the process is completed.

Click Finish.

A warning message appears stating that you must restart your computer to
complete uninstall process of Argus Insight.

Be sure to save your work and close other open applications before continuing.

Click OK to restart the Argus Insight Web Server.

12.1 Deleting the Argus Insight Folder from the Web Server

You must restart the server after the Argus Insight application is uninstalled. In
addition, you must manually remove the Argus Insight folder from the installation
directory. The install wizard does not automatically remove this folder.

To remove the Argus Insight folder after an uninstall:

1.
2.

Log in to the Argus Insight Web Server as a user with administrator privileges.

Go to the Argus Insight installation directory (that is, the directory where Argus
Insight was installed before you uninstalled the application).

Delete the Argus Insight folder and its contents from this location.

12.2 Resetting the IIS

If you uninstall Argus Insight, be sure to reset the Internet Information Services (IIS)
before you install the Argus Insight application again.
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Creating ODBC Connection for OBIEE

Administration Tool

This appendix comprises the steps to create ODBC connection for OBIEE
Administration tool.

1.
2

Navigate to Control Panel > All Control Panel Items > Administrative Tools.
Double-click Data Sources (ODBC) (64-bit).

The ODBC Data Source Administrator (64-bit) dialog box appears.

From the System DSN tab, and click Add.

The Create New Data Source dialog box appears.

From the list of the available drivers, select Oracle BI Server, and click Finish.

The Oracle BI Server DSN Configuration dialog box appears.

Enter the following fields:

a. Name—AIOBIEE (or any name)

b. Description—Argus Insight OBIEE (or any description)

c. Server—OBIEE Server Name

Click Next.

a. Login ID—weblogic

b. Password—<password for weblogic>

c. Port—The port must be same as mentioned in the Managed Server port list for
OBIEE BI Server.
To retrieve this port, go to Enterprise Manager > Bl Instance > Availability tab.

Click Next.

The Oracle BI Server DSN Configuration dialog box appears.
From the list of database, select AIS0O_SRC.
Click Finish.
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